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Prologue

Welcome

Welcome to Geing Started with Ubuntu, an introductory guide aimed at help-
ing new users get started with Ubuntu.

Our goal is to cover the basics of Ubuntu—su as installation and working
with the desktop—as well as guide you through some of the most popular ap-
plications. We designed the manual to be simple to follow—with step-by-step
instructions and plenty of screenshots, allowing you to discover the potential of
your new Ubuntu system even if you are a novice computer user or migrating
from another operating system for the first time.

is guide is still a work in progress, and always will be. It is wrien specif-
ically for Ubuntu . lts, and although we have tried not to limit our instruc-
tions to this version it is unavoidable that some things will ange over the life
of Ubuntu. Whenever a new version of Ubuntu is released, we will incorporate
these anges and also make available a new version of this guide.

What this guide is not

is document is not intended to be a comprehensive Ubuntu instruction man-
ual. It is more like a qui-start guide that will get you doing the things you need
to do with your computer quily and easily, without geing bogged down in
tenical details.

If you are aer more detail, there are excellent resources available at help.
ubuntu.com, produced by the Ubuntu Docs Team. e in-built system docu-
mentation in Ubuntu is also very useful for accessing help on specific topics.
is can be found by cliing on System ‣Help and Support in Ubuntu. If
something isn’t covered here, ances are you will find the information you are
looking for in one of those locations. More information about the on-line docs and

the system docs can be found in Chapter :
Learning more about Ubuntu.

Ubuntu philosophy

e term “Ubuntu” is a traditional African concept that originated from the
Bantu languages of southern Africa. It can be described as a way of connect-
ing with others—living in a global community where your actions affect all of
humanity. Ubuntu as we know it is more than just an operating system: it is a
community of people that come together voluntarily to collaborate on an inter-
national soware project that aims to deliver the best possible user experience.

help.ubuntu.com
help.ubuntu.com
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The Ubuntu promise

‣ Ubuntu will always be free of arge, along with its regular enterprise re-
leases and security updates.

‣ Ubuntu comes with full commercial support from Canonical and hundreds
of companies from across the world.

‣ Ubuntu provides the best translations and accessibility features that the free
soware community has to offer.

‣ Ubuntu core applications are all free and open source. We want you to use
free and open source soware, improve it and pass it on.

A brief history of Ubuntu

Ubuntuwas conceived in  byMark Shuleworth, a successful SouthAfrican
entrepreneur, and his company Canonical. Shuleworth recognized the power
of Linux and open source, but was also aware of weaknesses that prevented
mainstream use. Canonical, the financial backer of Ubuntu,

provides support for the core Ubuntu system.
It has over  paid staff members worldwide
who ensure that the foundation of the op-
erating system is stable, and also check all
the work submied by volunteer contribu-
tors. To learn more about Canonical, go to
http://www.canonical.com

Shuleworth set out with clear intentions to address these weaknesses and
create a system that was easy to use, completely free (see Chapter : Learn-
ing more about Ubuntu for the definition of “free”), and could compete with
other mainstream operating systems. With the Debian operating system as a
code base, Shuleworth began to build Ubuntu. Using his own funds at first,
installation CDs were pressed and shipped worldwide at no cost to the end user.
Ubuntu spread quily and the size of the community rapidly increased, and it
soon became the most popular Debian-based Linux distribution.

Now with more people working on the project than ever before, Ubuntu
continues to see improvement to its core features and hardware support, and
has gained the aention of large organizations worldwide. For example in ,
Dell began a collaboration with Canonical to sell computers with Ubuntu pre-
installed. Additionally in , the Fren Police began to transition their entire
computer infrastructure to a variant of Ubuntu; a process whi has reportedly
saved them “millions of Euro” in Windows licensing fees. By the year ,
the Fren Police expect that all of their computers will be running Ubuntu.
Canonical profits from this arrangement by providing tenical support and
custom-built soware. While large organizations oen find it useful to pay for For information on Ubuntu Server Edition,

and how you can use it in your company,
visit http://www.ubuntu.com/products/
whatisubuntu/serveredition/features

support services, Shuleworth has promised that the Ubuntu desktop system
will always be free. As of , Ubuntu is installed on nearly % of the world’s
computers. is equates to millions of users worldwide—and is growing ea
year.

Linux

Ubuntu is built on the foundation of Linux, whi is a member of the Unix
family. Unix is one of the oldest types of operating systems and has provided
reliability and security in professional applications for almost half a century.

http://www.canonical.com
http://www.ubuntu.com/products/whatisubuntu/serveredition/features
http://www.ubuntu.com/products/whatisubuntu/serveredition/features
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Many servers around the world that store data for popular websites, su as
Facebook and Google, run some variant of a Unix system. Whilst modern graphical desktop envi-

ronments have generally replaced early
command-line based operating systems,
the command-line can still be a quick and
efficient way of performing many tasks.
See Chapter : The command-line for more
information, and Chapter : Around your
Desktop to learn more about GNOME and
other desktop environments.

Linux was designed from the ground up with security and hardware compat-
ibility in mind, and is currently one of the most popular Unix-based operating
systems. One of the benefits of Linux is that it is incredibly flexible and can be
configured to run on almost any device, from the smallest micro-computers and
cellphones, to larger super-computers. Initially, Linux was entirely command-
line based, until graphical user interfaces (guis) began to emerge in the late
’s. ese early guis were difficult to configure and clunky at best, and
generally only used by seasoned computer programmers. In the past decade
however, graphical desktop environments have come a long way in terms of us-
ability, reliability and appearance. Ubuntu is just one of many different Linux
distributions, and uses one of the more popular graphical desktop environments
called GNOME.

M I S S I N G S C R E E N S H O T

Screenshot of the entire default GNOME desktop and nautilus

Figure : Screenshot of the entire default
GNOME desktop and nautilus

Is Ubuntu right for you?

New users to Ubuntu may find that it takes some time to feel comfortable with
the operating system. You will no doubt notice some similarities to both Mi-
croso Windows and Mac OS X, as well as some things that work very differ-
ently. Users coming from Mac OS X are likely to notice more similarities due
to the fact both these operating systems originated from Unix.

Before you decide whether or not Ubuntu is right for you, we suggest giving
yourself some time to grow accustomed to the way things are done—and expect
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to find differences. We also suggest taking the following into account:

‣ Ubuntu is community based. at is, Ubuntu is made, developed andmain-
tained by the community. Because of this, support is probably not available
at your local computer store—in fact the employees may never have even
heard of Ubuntu. ankfully, the community is there to help. ere are a lot
of articles, guides, and manuals available, as well as users on various inter-
net forums and Internet Relay Chat (irc) rooms that are willing to help out
beginners to Ubuntu. Additionally, near the end of this guide we include a
troubleshooting apter: Chapter : Troubleshooting.

‣ Many Windows or Mac applications will not run on Ubuntu. For the
vast majority of tasks that people use their computers for everyday, there
are suitable applications available in Ubuntu. However many professional
applications (su as the Adobe Creative suite) are not developed to work
with Ubuntu. If you rely on commercial soware that is not compatible
with Ubuntu, yet still want to give Ubuntu a try, you may want to consider
dual-booting. See Chapter : Soware and Packaging

to learn more about the Soware Center.
To learn more about dual-booting (running
Ubuntu side-by-side with another operating
system), see Chapter : Installation. For
more information on , go to http://
www.winehq.org/

‣ Many commercial games will not run on Ubuntu. If you are a heavy
gamer, then Ubuntu may not be for you. Game developers usually design
games for the largest market, where they can make the most profit. Since
Ubuntu’s market share is not as great as Windows or Mac, most game de-
velopers will not allocate resources towards making their games compatible
with Ubuntu. If you like to play a game every now and then, there is active
game development within the community, and many high quality games can
be easily installed through the Soware Center. Additionally, some games
developed for Windows will work in Ubuntu with a program called wine.

Contact details

Many people have contributed their time freely to this project. If you notice
any errors or think we have le something out, feel free to contact us. We will
do everything we can to make sure that this manual is current, informative and
professional. Our contact details are as follows:

e Ubuntu Manual Team

Home Page: http://www.ubuntu-manual.org/

Launpad Page: https://launchpad.net/~ubuntu-manual

Mailing List: ubuntu-manual@lists.launchpad.net

Project Wiki Page: https://wiki.ubuntu.com/ubuntu-manual

Ubuntu Manual Planet: http://planet.ubuntu-manual.org/

http://www.winehq.org/
http://www.winehq.org/
http://www.ubuntu-manual.org/
https://launchpad.net/~ubuntu-manual
ubuntu-manual@lists.launchpad.net
https://wiki.ubuntu.com/ubuntu-manual
http://planet.ubuntu-manual.org/


 Installation

Geing Ubuntu

Before you can get started with Ubuntu, the first thing you will need to do is get
hold of the Ubuntu installation CD. ere are several options available to you
for obtaining a copy of the CD, as follows.

Downloading Ubuntu

e easiest and most common method for geing Ubuntu is to download the
Ubuntu CD image directly from http://www.ubuntu.com. Simply head to the
website and cli the “Download Ubuntu” buon at the top. You will be asked
to select a download location, and then cli the “Begin Download” buon.

-bit vs -bit

You may notice that the default download buon on the website says “Ubuntu
Desktop . (-bit)” underneath. If you are unsure what -bit means, don’t
worry. -bit will work on most computers, so if in doubt, simply proceed with
the download. However if you know that your computer is capable of using
-bit soware, you may wish to try the -bit version instead. Simply cli the
“Alternative download options” buon and make your selection.

Downloading Ubuntu as a torrent

When a new version of Ubuntu is released, sometimes the servers can get clogged
up with large numbers of people downloading or upgrading at once. If you are
familiar with using torrents, youmaywish to download the .torrent file by cli-
ing “Alternative download options”, and obtain your copy of the CD image this
way instead. You may see significant improvements to your download speed,
and will also be helping to spread Ubuntu to other users worldwide. Again if
you are unsure what a torrent is, simply stiwith the default download options
on the website and you will be fine.

Burning the CD image

Once your download is complete you will be le with a file called “ubuntu-
.-desktop-i.iso” or similar (note: the i refers to the -bit version).
is file is a CD image—a bit like a ‘snapshot’ of the contents of a CD—whi
you will need to burn to a CD disc. To find out how to burn a CD image
on your computer, refer to your operating system or manufacturer help. You

http://www.ubuntu.com
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can also find detailed instructions at https://help.ubuntu.com/community/
BurningIsoHowto.

Ordering a free CD

Alternatively, you can order a free CD from Canonical. is option may be
preferred if you don’t have access to a CD burner, have limited bandwidth, or a
slow internet connection. ere are no shipping costs or other arges when
you order a Ubuntu CD. Simply visit http://shipit.ubuntu.com to request
your free Ubuntu Desktop Edition CD. e CD usually takes from four to ten Note: Youwill be required to create a free on-

line account with Launchpad before you can
place your CD order. Once you have Ubuntu
installed and running, you will be likely to
need this account again for various purposes.

weeks to arrive, depending on your location and current demand. If you would
rather get started with Ubuntu sooner, you may prefer to follow the instructions
above for downloading the CD image, and then burn it to a disc instead.

The Live CD

e Ubuntu CD that you have downloaded and burnt to a disc (or had shipped
out to you) functions not only as an installation CD for puing Ubuntu onto
your computer, but also as a Live CD. A Live CD allows you to test Ubuntu
withoutmaking any permanentanges to your computer, by running the entire
operating system straight from the CD.

e speed at whi your computer can ‘read’ information from a CD is mu
slower than reading information from a hard drive. Running Ubuntu from the
Live CD also occupies a large portion of your computer’s memory, whiwould
usually be available for programs to access when Ubuntu is running from your
hard drive. Because of this, the Live CD experience will feel slightly slower than
it does when Ubuntu is actually installed on your computer. However, running
Ubuntu from the CD is a great way to test things out, and allows you to try
some default applications, browse the internet, and get a general feel for the
operating system. It’s also a great way to e that your computer hardware
works properly in Ubuntu and that there are no major compatibility issues.

To try out Ubuntu using the Live CD, simply insert the Ubuntu CD into
your CD drive and restart your computer. Most computers are able to detect
when a ‘bootable’ CD is present in your drive at startup—that is, a CD that
will temporarily take precedence over your usual operating system. As your
computer starts, it will run whatever information is on this bootable CD, rather
than the information the computer usually looks for whi is stored on your
hard drive. In some cases, your computer will simply run

as normal and appear not to recognize there
is a CD present when it starts up. This is ok,
generally it means that the priority given to
different devices when your computer starts
up needs to be changed. For example, your
computer might be set to look for informa-
tion from your hard drive first, and then to
look for information on a CD second. In or-
der to run Ubuntu from the Live CD, we need
it instead to look for information from a CD
first. Changing your boot priority is beyond
the scope of this guide. If you need assistance
to change the boot priority, see your com-
puter manufacturers documentation for more
information.

Once your computer finds the Live CD, you will be taken to a menu that
looks like the following:

Choose the option “Try Ubuntu without installing” and press Enter on your
keyboard to start running Ubuntu from the Live CD.

Once Ubuntu loads, you will see in front of you the default desktop. We
will talk more about how to actually use Ubuntu in Chapter : Around your

https://help.ubuntu.com/community/BurningIsoHowto
https://help.ubuntu.com/community/BurningIsoHowto
http://shipit.ubuntu.com
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M I S S I N G S C R E E N S H O T

Live CD boot menu

Figure .: Live CD boot menu

Desktop, but for now feel free to test things out, open some programs, ange
seings and generally explore—any anges you make will not be saved once
you exit, so you don’t need to worry about accidentally breaking anything.

Once you are finished testing things out, simply restart your computer by
cliing the buon in the top right corner of your screen and selecting Restart….
Follow the prompts that appear on screen, including removing the Live CD, and
then your computer will restart. You will find that it has returned to it’s original
state as though nothing ever happened!

Installing Ubuntu

Ubuntu is easy to install. Installation is a very streamlined and fast process and
most people should not have any difficulty geing their system up and running..

.

.
Recommend rephrasing so that if a
user has difficulty installing, they
do not start to think that they’re
dumber than most .

Even though it’s easy to install, we still include a step-by-step guide to ensure
nothing goes wrong! However, we do suggest using the Live CD to test out
Ubuntu before installing to see if you like it, and also to ensure that it works
well with your hardware.

Using Wubi

Wubi stands for Windows Ubuntu Installer, and it allows you to install Ubuntu
inside Windows. Once installed, Ubuntu will appear in your Add/Remove pro-
grams (in Windows) like any other application. When it installs Ubuntu, it will
set up a series of files (called loop files) whi you can specify in size, where
it stores all of Ubuntu’s data. It will also add an entry to the Windows boot
loader, so when you reboot your computer you will be able to oose between
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Windows or Ubuntu.
It’s a very simple way to dual-boot and test out Ubuntu running natively on

your maine—and, if you don’t like it, just uninstall Ubuntu from theWindows
Add/Remove Programs menu. It won’t harm your Windows installation in any
way.

ere are a couple of things to keep in mind when using Wubi:

‣ If you install Ubuntu using Wubi, and decide you like it but find yourself
running out of hard drive space, it is very difficult to increase the hard drive
space without having to completely reinstall Ubuntu.

‣ e read/write times will not be as fast as if Ubuntu was installed directly
onto your hard drive, instead of having to access the data through a virtual
hard drive.. It won’t be hugely noticeable, however ..

..
is sentence is confusing

.

.

.
if it’s not important, why mention
it? either make it important, or
remove this bullet point

.

M I S S I N G S C R E E N S H O T

Screenshot of Wubi dialog in Windows 

Figure .: Screenshot ofWubi dialog inWin-
dows 

Installing Ubuntu to your hard drive

To install Ubuntu directly to your hard drive, you will need to have at least
 GB free on a partition somewhere to install the base system. We recommend
at least  GB for extra programs and your own content. You can either install
Ubuntu over Windows and erase Windows, or install it alongside Windows and
oose to dual-boot. e option for this is given to you in the partitioning stage
of the installation whi we cover in detail later on in this apter.
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Minimum system requirements:
Ubuntu will run on computers with lower
specifications than these, but you will need
to use the alternate CD to install Ubuntu.

Ubuntu should run reasonably well on a computer with the following minimum
hardware specification.

‣ MHz x processor
‣ MB of system memory (ram)
‣  GB of disk space
‣ Graphics card capable of × resolution
‣ Sound card
‣ A network or Internet connection

All -bit (x-) PCs should be able to run
Ubuntu. Use the -bit installation CD for
a -bit flavor of Ubuntu. Most computers
made aer  should have a -bit capable
processor. To check, contact your manufac-
turer and quote the model number.

First steps of installation

To get started, insert the Ubuntu CD into your disk drive and boot into the CD..

.
.
Need to explain what “booting
into a CD” means .

Choose your language with the arrow keys, and press Enter to select one.

M I S S I N G S C R E E N S H O T

Installation: Language options

Figure .: Installation: Language options

Press the down arrow so that Install Ubuntu is highlighted, then press Enter
on the keyboard. You can optionally choose Check disc for

defects to make sure no errors were encoun-
tered when burning your CD. You can also
test your computer memory () by choos-
ing Test memory.

Wait for a few seconds as the CD is loaded into your system memory..

.

.
Do we need to be specific here
about the CD being loaded into
memory? Recommend rephrasing
to remove advanced concept

.

Choose your native language and then cli on Forward to continue.

Tell Ubuntu where you are located by cliing on your location. is will set
the system clo for you. You can also use the drop-down list at the boom of
the screen. Cli on Forward to move on.
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M I S S I N G S C R E E N S H O T

Boot CD main menu with Install Ubuntu highlighted

Figure .: Boot CD main menu with Install
Ubuntu highlighted

M I S S I N G S C R E E N S H O T

Installation: Where are you? Screen

Figure .: Installation: Where are you?
Screen
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M I S S I N G S C R E E N S H O T

Installation: first installation screen

Figure .: Installation: first installation
screen

Next, you need to tell Ubuntu what keyboard you are using. Typically, the
default option should be satisfactory. Cli on Forward to continue once you
have tested your keyboard..

.

.
Unclear, is user supposed to test
their keyboard? We didn’t ask
them to. .

Guided partitioning

Next, oose how youwant to install Ubuntu. If youwant to delete your existing
operating system, or the hard drive is already empty and you want to let the
installer automatically partition.the hard drive for you, select the second option,

.

.
“Partition” is a new concept,
should be introduced before using
it .

Use the entire disk.

If you already have another operating system installed on your hard drive,
and want to install Ubuntu alongside it, oose the Install them side by side,
oosing between them ea startup option.

Specifying partitions manually

is option is for advanced users to create special partitions or format the hard
drive with other filesystems than the default one. But it can also be used to cre-
ate a separate /home partition, whi is very useful in case you have to reinstall
the whole system one day. Ubuntu installs a home folder where your

personal files and configuration data are lo-
cated by default. If you choose to have a sep-
arate home folder, then in the unlikely sce-
nario where you have to reinstall Ubuntu,
your personal files and configuration data
won’t be lost.

Who are you?
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M I S S I N G S C R E E N S H O T

Installation: keyboard screen

Figure .: Installation: keyboard screen

M I S S I N G S C R E E N S H O T

Installation: partitioning screen

Figure .: Installation: partitioning screen
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Installation: who are you? Screen

Figure .: Installation: who are you? Screen

Here you need .to tell Ubuntu:

.

.
Need? Should explain why
Ubuntu needs these, and the
privacy implications of specifying
this information .

‣ Your real name
‣ Your desired username
‣ Your desired password
‣ What you want to call your computer
‣ How you want Ubuntu to log you in.

e first three steps are self explanatory.. Choose a simple username, we

.
.
No, they are not… Recommend
explaining ea one individually

.
recommend just your first name, all lowercase. Your password should be strong
so no one can easily guess it.. .

.
Need to explain “strong” in more
detail; users do not know what
that means .

e name of your computer can be anything you like, although most people
generally oose something like “john-desktop” or “john-laptop.” e main rea-
son for this is to distinguish your computer from other computers on a network. To see how to set up a network, visit Chap-

ter : Working with Ubuntu.When oosing how to log in, you have three options:

Log in automatically

Ubuntu will log in for you when you start up the computer. It means you don’t
have to enter your password to get into your computer—not recommended due
to security reasons ..

.

.
Why is this not recommended?
We need to explain the pluses and
minuses; this is a legitimate option

.

Require my password to login

is option is the default—when you turn on your computer, you will need to
enter your password. is helps prevent unauthorized access to your computer.
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Require my password to login and decrypt my home folder

Your home folder is where all of your personal details are stored. By oosing
this option, Ubuntu will automatically enable encryption on your home folder,
so that it cannot be accessed unless your password unlos it. Even if some-
one had physical access to your hard drive, they would not be able to see your
files without your password entered on your computer. It’s very secure, and
recommended. Warning: If you choose to encrypt your home

folder, do not turn on automatic login in the
future as it will break your computer.

Confirm your seings and begin installation

Nothing you have actually specified yet has been wrien to the disk., so you .

.
Recommend omiing this detail;
just instruct the use to cli the
buon .

need to make sure that all your details are correct and then cli on Install to
begin the installation process.

M I S S I N G S C R E E N S H O T

Installation: confirmation screen

Figure .: Installation: confirmation screen

Ubuntu will now install. As the installation progresses, you will be presented
with a slideshow that gives you an introduction to some of the default applica-
tions included with Ubuntu.

Aer approximately twenty minutes, the installation will complete and you
will be able to cli Restart Now to restart your computer and start Ubuntu.
e CD will be ejected, so remove it from your CD drive and press Enter to
continue.

Aer the splash screen., you will see the login window.:

.
.
what about “..aer the screen with
the Ubuntu logo?

.

.
.
Not if the user uses automatic
login…

.
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Installation: first slide in the slideshow

Figure .: Installation: first slide in the
slideshow

M I S S I N G S C R E E N S H O T

Installation: screenshot of ”restart now” dialog box

Figure .: Installation: screenshot of
”restart now” dialog box
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Installation: screenshot of the GDM login

Figure .: Installation: screenshot of the
GDM login

Cli your username and enter your password, then press Enter or cli on
Log in to log in to Ubuntu and see your new desktop!



 Around your Desktop

The GNOME environment

GNOME (GNU Network Object Model Environment) is the default desktop en-
vironment used in Ubuntu. Most of the desktop you see in front of you will
be part of GNOME. Although the GNOME desktop environment is highly cus-
tomizable (as is true with many of Ubuntu’s features), we will deal with the
default desktop, as described below.

Understanding the desktop

The desktop

Mu like Windows or Mac OS X, Ubuntu uses a graphical user interface (GUI)
and a window management system to provide user interaction with applica-
tions.

By default, the desktop will have panels at the top and boom. A panel is a bar that sits on the edge of your
screen. It contains applets which provide
useful functions such as running programs,
viewing the time or accessing the main menu.

e desktop itself will have a wallpaper that is part of the default Ubuntu
theme, known as the Human theme. e desktop is highly customizable. You
can move the panels to the sides of the desktop, set the panels to autohide, and
you can remove or add panels as you desire. By default, Ubuntu requires that
you maintain at least one panel on the desktop. If you prefer a Windows look, a
panel at the boom of the desktop can be set up to open and do programs. If
you prefer a Mac OS X look, you can keep the top panel and add an applications
do. Some applications dock programs you can

check out include Avant Window Naviga-
tor (AWN), Cairo-Dock, and GNOME-Do
with Docky, all of which are available in
the Ubuntu Soware Center or Synaptic
Package Manager.

You can ange the wallpaper, and place program launers or file shortcut
icons on the desktop. For now, we will look at the default desktop and the
options that it offers. As we move forward in this apter, you will learn how
to make some basic modifications to the desktop.

The top panel

e default Ubuntu desktop has panels at the top and boom. We will briefly
look at the applets on the top panel. Starting from the le, you will see three An applet is a small application that runs

within a programmenu headings: Applications, Places, and System. Aer that, you will see two
program icons; the Firefox web browser launer, and the Ubuntu help launer.
To the right of the panel you’ll find the Notification Area, whi is similar to the
system tray in Windows or, more similar to the “menu extras” on the Mac OS X
menu bar. To the right of that is theMeMenuwith the name you entered during
installation. is applet allows you e emails, receive instant messages and
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Figure .: The Ubuntu . desktop.
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update social network sites like Twier and Facebook. Finally, on the far right,
is the power buon icon. When you cli on it, a menu opens with options
for loing your computer, logging yourself out, restarting, or shuing it down
completely.

e top panel is customizable. Right-cli on any open area of the panel
to access the options menu. You can add applets to the panel for reference,
information, or fun. You can also add program launers to the top panel by
opening the Applications menu. Once you find the program, drag it to an open
space on the panel. In this way, the panel also serves as an applications do.
You can also adjust panel properties, su as orientation of the panel on the
screen (top, boom, le, right), panel size, and panel color and transparency.

The Notification Area

Just asWindows has the system tray andMac OSX has themenu extras, Ubuntu
has the Notification Area. e items that you’ll find there include the volume
adjustment, network indicator, Bluetooth indicator (if your computer has Blue-
tooth capability), new mail notification applet, and the date and time. Some
programs will install an icon in the Notification Area when you first open them,
su as Tomboy Notes or Rhythmbox, and other programs will put an icon there
when modifications are made in the program.

For example, if you adjust the seings in OpenOffice.org so that it will load
into memory (for faster startup when you need to look at a document, etc.), an
OpenOffice.org icon will appear in the Notification Area. Right-cliing most
icons in the Notification Area will bring up a list of options available. e only
right-cli features available on the sound and mail/IM notification icons allow
you to lo the icon’s position on the panel, or remove it entirely. Some icons
in the Notification Area also perform actions .when you le-cli on them. To

.

.
e icons don’t perform the ac-
tions… the user does. Suggest
rephrasing. -ilya

.
adjust the volume, just cli on the volume adjustment icon and the volume
slider will appear. When you cli on the date and time, a calendar opens. If
you use Evolution to send and receive your email, you can cli on a date on the
calendar and it will open up your Evolution calendar on the date you clied.

Below the calendar is the Location box. Cli the + sign to show the world
calendar. To enter your location, cli on the Edit buon. In the window that
opens up, cli on the Add buon. Type your location in the box. If you live in
a major city, it may be on the list already. If your location isn’t in the list, you
can enter the latitude and longitude for your location (you can sear online if
you don’t already have this information). Make sure to select the time zone for
your location. If your location is on the list, you will be able to display weather
data for it below the calendar.

The boom panel

When you open a program, or a window, in Ubuntu, it will be displayed as a
buon on the boom panel. is is similar to the taskbar in Windows, or the
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boom portion of the Do in OS X.
At times, your desktop may get cluered, and you may wish to minimize

all the open windows. Cli on the Show Desktop buon on the far le of the
boom panel. All programs on your screen will minimize and you will see your
desktop. Cli the same buon again to re-open any windows you had open.

On the far right side of the panel, you’ll find the workspace switer. By
default, it is set for two workspaces. You can use multiple workspaces to have
two or more different desktops with their own sets of open windows. Ubuntu can be set to provide two or more

“virtual desktops,” or workspaces. Using
these workspaces can reduce desktop cluer
by opening many items on many desktops,
without needing a separate monitor. The
desktop switcher is located on the right side
of the boom panel.

To swit workspaces, just cli on the portion of the switer that isn’t
highlighted. is makes it possible to, say, have a web browser open in one
workspace, and a text document you’re working on in the other workspace,
thus reducing cluer on your screen. To add more workspaces, right-cli on
the icon and select Preferences. For example, if you would like to have four
workspaces you could select  rows by  columns (or  row by  columms).
Also on the right side of the panel is the Trash applet. is is mu like the
Recycle Bin in Windows or the Trash in OS X. Any files you delete go to the
Trash. To see the contents of the Trash, cli on it to open its window. Once
the window is open, you can empty the trash by cliing on the Empty Trash
buon. You can also empty the trash by right-cliing the Trash and selecting
Empty Trash from the menu.

Managing windows

Managing your program windows in Ubuntu works in mu the same way as
Windows and OS X. Your typical program window will have an icon or buon
of some sort in the top le corner of the window. When you right-cli on that
buon or icon, a menu will open with some options for manacing widnows (for
example Minimize, Maximize, Always on Top, etc). e name of the program
or file is displayed on the top of the window frame.

Closing, maximizing, restoring, and minimizing windows

To close a window, cli on the “X” in the upper right corner of the window.
Just to the le of the “X” is a box-shaped icon that when clied will “maximize”
the window, making it fill the entire screen.

Cli the maximize buon a second time, and the window will return to its
original size. If you want to minimize the window to the lower panel, cli the
“-” buon. To display the window on the desktop again, cli the spot on the
lower panel where the window’s name is displayed.

Moving and resizing windows

To move a window around the workspace, place the cursor on the top of the
window, then cli and drag the window. To resize a window, place the cursor
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Window buons, close, max, min

Figure .: Window buons, close, max, min

on and edge or corner of the window so that it turns into a larger arrow, the
resize icon. You can then cli and drag to resize the window.

Switching between open windows

ere are two ways in Ubuntu to swit between open windows in a workspace.
You can find the window on the boom panel taskbar and cli to bring it up
on the screen, or you can use Alt+Tab to select the window you wish to work
on. Press-and-hold down the Alt key, and keep pressing the Tab buon until
the window you’re looking for appears on the desktop.

Geing help

Ubuntu, just like other operating systems, has a built-in help reference, called
the Ubuntu Help Center. To access it, cli on the Help icon—a blue circle with
a white question mark (?) in the middle. You can also access it as “Help and
Support” through the System menu on the top panel.

is manual should give you answers to many of your questions as you
start learning the Ubuntu operating system. If you need more information, the
Ubuntu Help Center mentioned previously, and the help documentation built
in to many of the programs, should provide you with the answers you seek.
You can also e out the Ubuntu Wiki or Ubuntu Forum. Many Ubuntu users
also find that problems can be solved by searing for information on the Web
using a sear engine su as Yahoo or Google. Should you oose to get help
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Help and support icon

Figure .: Help and support icon

by searing the Web, please e any information you find using multiple
sources, and only follow directions if you understand them completely. If you can’t find an answer to your question

in the Help Center, you can reach out to the
Ubuntu community through the Ubuntu Fo-
rum. Many Ubuntu users open an account on
the Forum to receive help. Later, as they gain
knowledge of Ubuntu, they provide help to
others. http://ubuntuforums.org. Another
useful website is the Ubuntu Wiki, main-
tained by the Ubuntu community. https:
//wiki.ubuntu.com

Using the Applications Menu

ere are three menu headers in the top panel. Let’s take a look at those menus
in a bit more detail, starting with the Applications menu.

You may find that there are programs in the
Applications menu that you don’t use fre-
quently, or just don’t want to be displayed on
the menu. To hide those applications (with-
out deleting the actual programs), click on
System menu and select Preferences ‣Main
Menu. Find the applications in the right
panel that you want to remove from the Ap-
plications menu, and click to un-check the
box.

Accessories

e Accessories sub-menu has many programs that are suited for productivity,
including Calculator and Tomboy Notes. Other programs in Accessories in-

See Chapter : Working with Ubuntu for
more information about the included appli-
cations.

clude the CD/DVD Creator, gedit text editor (similar to Windows Notepad and
OS X’s TextEdit), Sear for Files (we’ll discuss that later), and Take Screenshot,
whi allows you to take a picture of your desktop screen.

Games and Applications

Ubuntu has several games built in for your entertainment. If you enjoy card
games, e out AisleRiot Solitaire. Perhaps you’re looking for more of a al-
lenge: in that case, there’s gBrainy and Sudoku. e Games menu also includes
Mahjongg, Mines (similar to Windows Minesweeper game) and adrapassel
(similar to Tetris).

http://ubuntuforums.org
https://wiki.ubuntu.com
https://wiki.ubuntu.com
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Graphics

Under the Graphics sub-menu, you’ll find the F-Spot photo manager, OpenOf-
fice Drawing, and some scanner applications.

Internet

e Internet sub-menu is where you will find the Firefox web browser, Empathy
IM client, and Ubuntu One, an online storage site that syncs with your Ubuntu
data.

Office

e Office sub-menu is where you will find your OpenOffice programs (word
processing, spreadsheet, etc.), the Evolution mail client, and an on-line dictio-
nary.

Sound and Video

e Sound and Video sub-menu has programs for working with multimedia,
su as the Brasero Disk Burner, Totem Movie Player, Pitivi Video Editor,
Rhythmbox Music Player, and Sound Recorder.

Ubuntu Soware Center
See Chapter : Soware and Packaging for
more information about the Ubuntu Soware
Center

At the very boom of the Applications menu is the Ubuntu Soware Cen-
ter. is application gives you access to a library of free soware that you can
download. e main screen in the Soware Center is similar to your Applica-
tions menu, for easy searing. If you know the name of the program you’re
looking for, just enter it in the sear box on the top right of the Soware Cen-
ter window. e Soware Center keeps tra of programs that are installed on
your computer. If you’re simply curious as to what is available, you can explore
the soware available using the categories listed on the le side of the window.

Using the System Menu

e system menu, located on the top panel, contains two important sub-menus.
ose sub-menus, Preferences and Administration, make it possible for you to
make modifications to how your system looks and works. rough the System
menu, you can also open the Ubuntu Help Center (Help and Support), find out
more about your GNOME desktop environment (About GNOME), and find out
more about Ubuntu in general (About Ubuntu). e System menu and its sub-
menus are the equivalent of the Control Panel in Windows and OS X’s Systems
Preferences. See Chapter : Preferences and Hardware for

more detailed information about the options
available in the System menu.
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Preferences

You can use the Preferences sub-menu to modify the appearance of the desktop
and windows, assign a default printer, designate keyboard shortcuts, ange the
entries listed in the Applications menu, edit network connections, and ange
mouse seings, among other options.

Administration

e Administration sub-menu contains programs you can use to monitor com-
puter performance, ange disk partitions, activate third-party drivers, manage
all installed printers, and manage how your computer receives updates from
Ubuntu. is sub-menu also has the Synaptic Paage Manager, whi is a
more tenical resource for locating and downloading soware paages.

Browsing files on your computer

ere are two ways to locate files on your computer. You can use the Sear
for Files tool in the Applications menu, under Accessories. You can also use the
Places menu on the top panel.

Places

e Places menu is a list of commonly used folders (su as Home Folder, Doc-
uments, Music, Downloads). You can also browse all disks on the computer by
cliing on Computer in the Places menu. If you set up a home network, you
will find a menu item to access shared files/folders. You can also access the
Sear for Files tool from the Places menu, and browse a list of recently opened
documents.

Your home folder

e home folder is where ea user’s personal files are located. When you in-
stalled Ubuntu, you entered a name to set up your user account. at same
name is assigned to your folder in the Home Folder. When you open your per-
sonal folder, you will see that there are several folders there—Desktop (any files
that are located on the Desktop), Documents, Downloads, Music, Pictures, Pub-
lic, Templates, and Videos. You will also see a link named Examples. Double-
cli on that link to open a folder full of example documents, spreadsheets, and
multimedia.

Nautilus file browser

Just as Windows has Windows Explorer and OS X has the Finder to browse files
and folders, Ubuntu uses theNautilus file browser by default. We will now look
at the features offered in Nautilus.
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The Nautilus file browser window

When you open a folder on the Desktop or from the Places menu, the Nau-
tilus file browser window opens up. e standard browser window contains
the following features:

‣ Menubar: e menubar is located at the top of the window. ese menus al-
low you to modify the layout of the browser, navigate, bookmark commonly
used folders and files, and view hidden folders and files. If you bookmark a folder, it will appear in the

Places menu.‣ Toolbar: e toolbar has tools for navigation and a tool to make the contents
of the window larger or smaller. A drop-down list gives you the option of
switing the view from Icon View to List View or Compact View. e sear
icon (whi looks like a magnifying glass) opens up a box so you can sear
for a file by name.

‣ Additional Navigation Tools: Just below the toolbar, you will see a represen-
tation of where you are currently browsing, similar to the “tree” you find on
many forum sites. You can cli on the locations to navigate ba through
the file browser.

‣ e le pane of the file browser has shortcuts to commonly used folders.
When you bookmark a folder, it appears in the le pane. No maer what
folder you open, the le pane will always contain the same folders. is le
pane can be anged to display different features by cliing the down arrow
beside “Places” near the top.

‣ e largest, central pane shows the files and folders in the directory that
you’re currently browsing.

Opening files

To open a file, you can either double-cli on its icon or right-cli and select
Open With (program).

Copying and moving files and folders

You can copy files through the Edit menu in Nautilus (either using Copy or
Copy To), or by right-cliing on the file and selecting Copy or Copy to from the
popupmenu. When using the Edit menu inNautilus, make sure you’ve selected
the file (cli on it to select it) before you cli on the Edit menu. Multiple
files can be selected by holding the le mouse buon down while dragging the
cursor across the files you want. e cli-drag move is good when you are
selecting files whose icons are grouped together. To select files that are not
grouped together, press-and-hold the Ctrl key and cli on ea file you wish
to select.

To move files and folders around, locate the file or folder you want to move.
Cli-and-hold on the file or folder and drag it to the new location. Another
way of moving folders or files is to use the Copy command, followed by Paste
in the new location.
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Navigating between directories

To navigate between directories, use the bookmarks in the le pane of the Nau-
tilus file browser. You can also retrace your steps by cliing on the name of a
folder where it is listed just below the navigational icons. Double-cliing on a
visible directory will cause you to navigate to it in Nautilus.

Creating new folders

To create a new folder, you can either right-cli on the file browser window (or
on the Desktop) and select Create Folder from the popup menu, or select Create
Folder from the File menu in Nautilus. If you wish to hide certain folders or
files, place a dot (.) in front of the file name (i.e. “.Personal Finances”). You can view hidden files by clicking the

“View” menu and then clicking on “Show
Hidden Files” or by pressing Ctrl+H.

Using multiple tabs and multiple nautilus windows

e Nautilus file browser gives you the option to do tabbed browsing as an al-
ternative to opening several Nautilus windows. To open new tabs in Nautilus,
select New Tab from the File menu. If you prefer having separateNautiluswin-
dows open, select New Window from the File menu. You can move files and
folders using the drag method using either separate windows or tabbed brows-
ing. When you open a new tab, it will produce a second window of the current
directory that you’re working in. To select a different directory for the new tab,
navigate to the desired location using the le pane.

Searching for files on your computer

Eariler, we found that you can sear for files on the computer by using the
Sear for Files feature on the Places menu in the top panel. We also discovered
that you can use the Nautilus browser to sear for files, as explained above.
Some files or folders may have dot (.) in front of the file or folder name. ose
files and folders are hidden files. To display hidden files in Nautilus, select
“Show Hidden Files” from the View menu in the file browser or press Ctrl+H.

Customizing your desktop

Now that you’ve been thoroughly introduced to the GNOME desktop environ-
ment, let’s take a look at customizing its features.

Appearance

ere are many things you can do with the desktop appearance. e panels
can be moved from their top or boom positions to the sides of the screen, they
can be set to hide, or you can ange the panel color. To access these features,
right-cli the panel you want to modify and select Properties from the pop-up
menu. e General tab has options to autohide, position the panel, and ange
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the panel size. By default, the panels cover the entire length of the desktop. To
ange that, un-e the Expand box. To hide the panel on the le or right
corner of the desktop, select the Show Hide Buons. To put arrows on the hide
buons, e the Arrows on Hide Buons box (by default, this box will be
eed when you select Show Hide Buons). To make the panel disappear,
select Autohide. e panel will reappear when you place the cursor on the side
of the screen where the panel was before it hid. e Baground tab in Panel
Properties allows you to use the system theme (default seing), or select a color
of your oosing. You can also set the transparency of the panels, or even select
a picture or design from your files as a panel baground. You can also choose to delete the panels, and

install a Mac OS X-style dock. Two dock pro-
grams available in the Ubuntu Soware Cen-
ter are Cairo-Dock and Avant Window Nav-
igator (AWN).

Changing the desktop baground is quite simple. You can either right-cli
on the desktop and select Change Desktop Baground from the pop-up menu,
or, from the top panel, select the System menu, Preferences, Appearance. When
the Appearance Preferences window opens up, cli on the Baground tab. You
will see some sto bagrounds to oose from. If you are looking for some-
thing beyond these, you can use any picture on your computer as a desktop
baground. Cli on the Add… buon and find the picture you wish to use.
Double-cli on it, and the ange will take effect immediately. Once you do
this, the picture will become available in the Appearance Preferences. To find
even more great desktop bagrounds, cli on the “Get More Bagrounds On-
line” link at the boom of the Appearance Preferences window. is link will
open your web browser, and direct you to the GNOMElook.org website.

You can also ange the fonts through the Appearance Preferences window.
Just cli on the Fonts tab. You can individually set the font style and size for
applications, documents, desktop items, window titles, and for anything using
fixed width fonts. e Rendering section at the boom of the Fonts window
gives you four options for font rendering.

Windows

e Appearance Preferences window has a eme tab, where you can select a
theme that will control the appearance of your windows, buons, scroll bars,
panels, icons, and other parts of the desktop. Ubuntu comes with nine themes
to oose from, and the Human theme is selected by default. You can download
additional themes by cliing the “Get More emes Online” link on the boom
of the emes window. e link will take you to the GNOMElook.org website,
where you can download from a large selection of themes. To add downloaded
themes to the emes tab, drag the downloaded file into the emes window
(this will work for most themes). You can customize any theme: select the
theme, and cli on the Customize buon. is will allow you to mix elements
of different themes, thus creating your own special theme.

GNOMElook.org
GNOMElook.org
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Screensaver

Ubuntu offers a selection of screensavers. By default, Ubuntu displays a bla
screen aer a period of inactivity. To select a different screensaver, cli on the
System menu on the top panel, select Preferences, and select Screensaver. is
will open the Screensaver Preferences window. e available screensavers are
listed on the le side of the window. When you select a screensaver, you will see
a mini-preview in the window. To see how it will look on your screen, cli the
Preview buon. To exit the preview, cli on the Leave Fullscreen buon on
the top of the screen. e le and right arrow buons in Fullscreen allow you to
scroll through the available screensavers while still in full screen mode. Make
sure that the Activate Screensaver When Idle option is selected to activate the
screensaver. e slider can be adjusted to set the idle time. For added security,
you can select the Lo Screen When Screensaver Is Active option. Ubuntu will
ask you for your login password when you return to using the computer.

Accessibility

Ubuntu has built-in tools that make using the computer easier for people with
certain physical limitations. You can find these these tools by opening the Sys-
temmenu, thenoosing Preferences, thenAssistive Tenologies. In addition
to the Assistive Tenologies, certain appearance tweaks, su as selecting
high contrast themes and larger on-screen fonts can assist those with limited
vision. You can also adjust keyboard and mouse seings through the Assis-
tive Tenologies window. Just cli on the Keyboard Accessibilty or Mouse
Accessibility buons in the Preferences section to access those features.

Assistive Technologies

Orca, a tool for persons with visual impairments, is pre-installed on Ubuntu.
To run Orca, Press ALT+F, type Orca in the command box, and cli on the
Run buon. You can also run Orca from the command line. To do this, open
a Terminal (Applications ‣Accessories ‣Terminal), type Orca at the prompt
and press Enter. Orca’s voice synthesizer will activate to navigate you through
the various voice options, Braille, and screen magnification. Once you have
selected all seings, log out of the computer. Once you log ba in, the Orca
seings you ose will automatically run every time you use your computer.

Shuing down your computer

When you’re done working on your computer, you can shut down the computer
or place it in standby through the Session Indicator applet on the far right end of
the top panel. You can also access these options by pressing the Ctrl+Alt+Del
keys.
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Logging out

To log out and leave the computer running, select Log Out from the Session
Indicator menu.

Rebooting

To reboot your computer, select Restart from the Session Indicator menu.

Shut down

To totally power down your computer, select Shut Down from the Session In-
dicator menu.

Other options

From the Session Indicator menu, you can also select Lo Screen to require a
password before using the computer again—this is useful if you need to leave
your computer for some duration. You can also use the Session Indicator menu
toset up a guest session for a friend to try Ubuntu, or to swit the desktop to let
another use another user account without closing your running applications.
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Geing online

Before you can use your computer to its fullest, you must make sure that you
are connected to the internet. is section of the manual will help you e or
configure you internet connection. While this manual discusses only the inter-

net, connecting to office or other networks is
usually performed in a similar manner.

Ubuntu can connect to the internet using a wired, wireless, or dialup con-
nection. It also supports some more advanced connection methods.

A wired connection is used when your computer is physically connected to
a router or an ethernet port via a cable. is is the most common connection
for desktop computers.

Awireless connection is used when your computer is connected to the inter-
net via a wireless radio network, also known as Wi-Fi. It is common for laptop
computers to use wireless connections, especially when on the go. In order to
connect to a wireless connection you must have a working wireless network.
is is usually the case if you’ve previously purased and installed a wireless
router or access point, or if you are in a place where a wireless network is
already established.

A dialup connection is when your computer uses a modem and a telephone
line to connect to an internet service provider.

Ubuntu can also connect using mobile broadband, VPNs, or DSLs. Note: A VPN is a “Virtual Private Network”,
and is sometimes used to help secure connec-
tions. DSLs are “Digital Subscriber Lines”, a
type of a broadband connection.

NetworkManager

In order to connect to the internet in Ubuntu, you need to use the Network-
Manager utility. NetworkManager allows you to turn all networking on or off,
and helps you manage your wired, wireless, and other connections.

You can access all the functions of NetworkManager using its icon in the
top panel. Its icon may look different if you already have a connection, or if
your connection is wired or wireless. If you hover your mouse over the icon, it
should read “Wired connection…” or “No connection” or “Networking disabled”
or something else related to networking or connections.

If you are currently connected to the internet, you can cli on the icon. is
will bring up a list of network connections that are available to you, with your
current connection highlighted in bold.

You can also right-cli on the NetworkManager icon. is will open a menu
where you can enable or disable networking, view tenical details about your
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Partial screen shot that points out network manager when connected with a wired
network (point it out with an arrow?)

Figure .: Partial screen shot that points
out network manager when connected with a
wired network (point it out with an arrow?)

M I S S I N G S C R E E N S H O T

NetworkManager with the menu open showing auto eth

Figure .: NetworkManager with the menu
open showing auto eth
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NetworkManager with the right-click menu open, showing Enable Networking checked

Figure .: NetworkManager with the right-
click menu open, showing Enable Network-
ing checked

current connection, or edit all connection seings. In the image above, thee
box next to “Enable Networking” is currently selected; you can deselect it to
disable all network connections. is may be useful when you must shut off all
wireless communication, for example in an airplane.

Establishing a connection

In order to get online, you need to make sure that you have established a con-
nection. ere are many different ways to connect to the internet with Ubuntu
—some of these we will cover below.

Wired

If you have an Ethernet wire running from a wall soet, a router, or some other
device, then you will want to create a wired network connection in Ubuntu.
is is the most common way for desktop and other stationary computers to
connect to the internet. Note: Are you already online? If the Net-

workManager icon in the top panel shows a
connection, then you may have successfully
connected during the installation process. If
so, you do not need to follow the rest of this
section.

In order to connect with a wired connection, you need to knowwhether your
network connection supports DHCP. is stands for “Dynamic Host Configu-
ration Protocol”, and is a way for computers on your network to automatically
receive IP addresses and related configuration. If you are unsure, try DHCP set
up first; if this does not work then ask your network administrator for static
address information.
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Automatic connections with DHCP

If your network supports DHCP, you may already be online. To e if you are
online, right-cli on the NetworkManager icon in the top panel and select the
Connection Information option.

M I S S I N G S C R E E N S H O T

The Connection Information window of NetworkManager

Figure .: The Connection Information win-
dow of NetworkManager

You should see a window showing details about your connection. If your IP
address is ..., or starts with ., then DHCP did not successfully provide
your computer an address. If it shows another address then most likely your
connection was configured correctly.

If you cannot display the Connection Information window because the op-
tion on the NetworkManager menu is gray then your connection is not active.
To see if your connection is turned on, verify that the Enable Networking op-
tion in the menu is selected.

en, cli on the NetworkManager icon. ere should be an option for
“Wired Network” in the menu that is displayed. If this option is followed by
a gray word “disconnected” then find the option called “Auto eth” in the list
and oose it to aempt a connection. If “Auth eth” is shown directly under
“Wired Network” then your computer is set up correctly for DHCP.

If aer following these steps you are still not online, you may want to e
with your network administrator and possibly proceed with manual configura-
tion with a static IP address.
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Manual configuration with static addresses

If your network does not support DHCP, then you need to know a few items of
information before you can get online.

‣ IP Address—this will be your computer’s address. It is always given in the
form of four numbers separated by decimal points. For example, ...

‣ Network mask—this tells your computer how large your local network is. It
takes the same form as an IP address, but is usually something like ...

‣ Gateway—this is an IP address of your network’s router: where your com-
puter sends data whi gets sent on to the internet

‣ DNS servers—one or more IP addresses of “Domain Name System” servers,
whi convert names likewww.ubuntu.com into IP addresses like ...;
one server is required, and any additional ones are used in case the first one
fails.

If you do not already have these seings, you will need to consult your net-
work administrator to receive them.

To manually configure a wired connection, right-cli on the NetworkMan-
ager icon, and select Edit Connections. Make sure you are looking at the
“Wired” tab in the “Network Connections” window that is displayed.

e list may already have an entry, su as “Auto eth”, or having some other
name. If a connection is listed, cli on it and then cli the Edit buon. If no
connection is listed, cli the Add buon instead.

If you are adding a connection, you first need to provide a name. In the
“Connection name” field, please provide some name su as “Wired connection
”.

To set up the connection:

. Under the connection name, make sure that the Connect automatically op-
tion is selected.

. Swit to the IPv Settings tab.
. Change the Method to “Manual”.
. Cli on the Add buon next to the empty list of addresses.
. Type in your IP address in the field below the IP Address header.
. Cli to the right of the IP address, directly below theNetworkMask header,

and type in your network mask. If you are unsure of your network mask, a
mask of “...” is the most common.

. Cli to the right of the network mask, directly below the Gateway header,
and type in your gateway address.

. In the DNS servers field below, type in the addresses of your DNS server. If
your network has more than one DNS server, enter them separated by spaces
or commas.

. Cli Apply to save your anges.
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manual connection editing screen, on the IPv tab

Figure .: manual connection editing screen,
on the IPv tab

In some cases, you may need to enter a MAC address as well. is is entered on
the “Wired” tab of the editing screen. A MAC address is a hardware address
for your computer’s network card, and entering it is sometimes important for
cable modem and similar connections.

When you are once again at the “Network Connections” screen, your newly-
added connection should now be listed. Cli Close to return to the desktop. If
you configured the connection correctly, the NetworkManager icon should have
anged to show an active connection. Use instructions in the DHCP section,
above, to e if your connection looks properly set up.

e final test of seing up your connection will come when trying to use a
web browser, as described later in this apter.

Wireless

If your computer is equipped with a wireless (Wi-Fi) card, and you have a
wireless network nearby, you should be able to set up a wireless connection
in Ubuntu.

Connecting to a wireless network for the first time

If your computer has a wireless network card, you should be able to connect to a
wireless network. Most laptop and netbook computers have a wireless network
card.

Ubuntu will usually detect available wireless networks. To see a list of wire-
less networks, cli on the NetworkManager icon. Under the “Wireless Net-
works” heading, you should see a list of available wireless networks. Ea net-
work will be shown with a name on the le, and a signal meter on the right. A
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signal meter looks like a series of bars—the more bars that are shown filled in,
the stronger is the connection that your computer has to that wireless network.

A wireless network may be open to anyone to connect, or may be protected
with network security. e list of available wireless networks should show a
small icon of a “lo” next to the signal meter to the right of the name. You will
need to know the correct password in order to connect to a secured wireless
network.

To connect to a wireless network, cli on one of the network names in the
list. You should know whi network you wish to connect to—it should be the
one that you had set up when you installed your wireless router or access point.
If you are in a place of business or education, the wireless network may be
named with the name of the place.

If the network is open (the network signalmeter did not have a lonext to it),
a connection should be established within a few seconds. e NetworkManager
icon in the top panel will display an animation while Ubuntu tries to connect
to the network, and should then ange to show signal meter bars once the
connection is established.

Ubuntu will also show a notification message in the upper right of your
screen informing you that a connection was established.

If the network is secured, Ubuntu will display a window called “Wireless
Network Authentication Required”. is window means that the wireless net-
work requires a password to allow a connection.

M I S S I N G S C R E E N S H O T

detail shot of the “Wireless Network Authentication Required” window

Figure .: detail shot of the “Wireless Net-
work Authentication Required” window

If you know the password, enter it in the Password field, and cli on the
Connect buon. When typing, a password will be obscured to prevent people
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looking over your shoulder from seeing the typed-in password. If you prefer
to see the password when typing it in, select the Show password option when
typing your password.

Aer you cli the Connect buon, the NetworkManager icon in the top
panel will display an animation while it tries to connect to the network. If
you had entered the correct password, the NetworkManager icon should then
ange to show signal meter bars when the connection is established.

Mu like for open wireless networks, Ubuntu will show a pop up message in
the upper right of your screen informing you that a connection was established.

If you did not provide the correct password then the NetworkManager icon
will display an animation, and then eventually once again display the “Wireless
Network Authentication Required” window. You will now be able to provide
the correct password, or cli Cancel to abort your connection. If you do not
know the password to the network you had selected, you will need to get the
password from the network administrator.

.Once you have a successful network connection established, Ubuntu will

.

.
Will users get prompted for a
keyring password here some-
where⁇ .

save this connection. is will make it easier to connect to the same wireless
network in the future.

Connecting to a saved wireless network

If you have previously successfully established a wireless connection, that con-
nection’s password will be saved on your computer. is will allow you to
connect to the same network without having to re-enter the password.

In addition, Ubuntu will automatically try to connect to a wireless network
within range if it has is seings saved. is will work for both open and secured
wireless network.

If you havemultiple saved wireless networks in range, Ubuntumayoose to
connect to one of them, while youmay prefer to connect to another. In this case,
cli on the NetworkManager icon. You should see a list of wireless networks
in range, along with their signal meters. Cli on your desired network.

If the password and other seings have not anged, Ubuntu will connect to
the wireless network you ose. If the password did ange, Ubuntu will open
the “Wireless Network Authentication Required” window. In this case, please
follow instructions in the previous section.

Connecting to a hidden wireless network

In some circumstances, you may need to connect to a hidden wireless network.
ese hidden networks do not broadcast their names—whi means that they
will not show up in the list of wireless networks in the NetworkManager menu.
In order to be able to connect to a hidden network, you will need to get its name
and its security seings from your network administrator.

To connect to a hidden network:

. Cli on the NetworkManager icon in the top panel.
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. Choose the Connect to Hidden Wireless Network option. Ubuntu should
open the “Connect to Hidden Wireless Network” window.

. By default, the Connection field should show “New…”—you can leave this
unanged.

. In the Network name field, enter the name of the wireless network. is
name is also known as an “SSID”. Please enter the network name exactly as
it was given to you.

. In the Wireless security field, select one of the options. If the network is
open, leave this field as “None”. If you do not know the correct seing for
the network you will not be able to connect to the hidden network.

. Cli on the Connect buon.

.e rest of the process shouldwork exactly as in the section on the initial con-

.
.
verify that the hidden network
does show up as described

.
nection to wireless networks. Once set up according to the instructions above,
the hidden network should show up in the list of saved networks.

Disabling and enabling your wireless network card

Wireless access in Ubuntu is enabled by default if you have a wireless network
card in your computer. In certain cases, for example on airplanes, you may need
or be required to turn your wireless radio off.

To do this, right-cli on the NetworkManager icon, and deselect the Enable
Wireless option. Your wireless network will be turned off, and your computer
will no longer sear for available wireless networks.

To turn wireless networking ba on, right-cli on the NetworkManager
icon, and cli on the Enable Wireless option to re-select it. Your wireless
network will be turned ba on. Ubuntu will then sear for nearby wireless
networks and will connect to any saved networks within range.

Changing an existing wireless network

At times, you may want to ange the seings for a wireless connection that
you have previously saved. Its password may have anged, or your system
administrator asked you to ange some networking or security seings.

To edit a saved wireless network connection:

. Right-cli on the NetworkManager icon and select Edit Connections…
. A “Network Connections” window should open. Cli on the Wireless tab

to see a list of saved wireless connections
. By default, this list shows connections in the order of most recently used to

least recently used. Find the connection you want to edit, cli on it, and
then cli Edit.

. Ubuntu should open a window called “Editing connection name”, where con-
nection name is the name of the connection you are editing. e window
should display a number of tabs.
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. Above the tabs, you may ange the Connection name field if you want to
give the connection a more recognizable name

. If the Connect automatically option is not selected, Ubuntu will detect the
wireless network but will not automatically connect to it without you oos-
ing it from the NetworkManager menu. Select or deselect this seing as
needed.

. On the Wireless tab of the “Editing connection name” window, you may
need to edit the SSID field. A “SSID” is the wireless connection’s network
name—if set incorrectly, the network may not be detected and a connection
may not be made. Please make sure that the SSID is set according to your
network administrator’s instructions.

. Below the SSID, you should see the Mode field. e “Infrastructure” mode
means that you would be connecting to a wireless router or access point.
is is the most common mode for wireless networks. e “Ad-hoc” mode
is a computer-to-computer mode and is oen only used in advanced cases.

. On theWireless Security tab of the “Editing connection name” window, you
may need to ange the Security field to the correct seing. A selection of
None means that you are using an open network with no security. Other
selections may require slightly different additional information:

‣ WEP /-bit Key is an older security seing still in use by some wire-
less networks. If your network uses this security mode, you will need to
enter a key in the Key field that should appear aer you select this mode.
e key is usually entered as a sequence of digits  through  and leers
A through F. .

.
.
is this true? or will it support a
passphrase too here?

.
‣ WEP -bit Passphrase is the same older security seing as the entry

above. However, instead of a key, your network administrator should
have provided you with a text passphrase—a password—to connect to the
network. Once you select this security mode, you will need to enter your
passphrase in the Key field.

‣ WPA & WPA Personal is the most common security mode for wireless
network connections at home and at businesses. Once you select this
mode, you will need to enter a password in the Password field.

‣ If your network administrator requires LEAP, Dynamic WEP, or WPA &
WPA Enterprise security, you will need to have the administrator help
you set up those security modes

. On the IPv Settings tab, you may need to ange the Method field from
“Automatic (DHCP)” to “Manual”, or one of the other methods. For seing
up manual seings (also known as static addresses), please see the section
above on manual set up for wired network connections.

. When you finish making anges to the connection, cliApply to save your
anges and close the window. You can cli Cancel to close the window
without making anges.

. Finally, cli Close on the “Network Connections” window to return to the
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desktop.

Aer making anges, your new seings should go into effect immediately. .
..

TODO confirm if this is true .

Troubleshooting common problems with wireless connections

. ..
Needs to be wrien or removed .

Dialup

Other connection methods

ere are other ways to get connected with Ubuntu.
With NetworkManager, you can also configure Mobile Broadband connec-

tions to keep online through your cellular or other mobile data carrier. .
..

expand; it’s actually prey simple
.

You can also connect to DSLs (Digital Subscriber Lines), whi are a method
of internet connection that uses your telephone lines and a “DSL modem”. .

..
expand

.
You can also use NetworkManager to establish a VPN (Virtual Private Net-

work) connection. ese are commonly used to create secure connectivity to a
workplace. . .

.
I think that in some areas, VPNs
are used in addition to normal
DSL/Cable/fibre connections to
the home… if so, need to cover
them here at least briefly

.Browsing the web

Once you have connected to the internet, you should be able to browse the web
with Ubuntu. e Mozilla Firefox is the default application for browsing the
web in Ubuntu.

Starting Firefox

To start Firefox, cli on theApplicationsmenu, then Internet, and select Fire-
fox Web Browser.

If your keyboard has a “WWW” buon, you can also press that buon to
start Firefox.

Navigating web pages

Viewing your homepage

When you start Firefox, you will see your home page. By default, you will see
the Ubuntu Start Page.

To display more web content on the screen, you can use Full Screen mode.
Full Screen mode condenses the Firefox’s toolbars into one small toolbar. To
enable Full Screen mode, simply select View ‣ Full Screen or press F11.

To go to your home page quily, press Alt+Home.
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Navigating to another page

To navigate to a new web page, you need to type its internet address (also
known as a URL) into the Location Bar. URLs normally begin with “hp://”
followed by one or more names that identify the address. One example is
“hp://www.ubuntu.com/”.

To navigate:

. Cli the Location Bar to select the URL that is already there.
. Type the URL of the page you want to visit. e URL you type replaces any

text already in the Location Bar.
. Press Enter.

To quily select the URL of the Location Bar, press Ctrl+L.
If you don’t know a URL, try typing something specific to the page you want

to visit (for example a name or other sear request) into the Location Bar and
press Enter. is will sear your preferred sear engine—Yahoo by default
—for that term, and take you to the web page that is the top result from the
sear.

Clicking a link

Most web pages contain links you can cli to move to other pages.
To cli a link:

. Move the mouse pointer until it anges to a pointing finger. is happens
whenever the pointer is over a link. Most links are underlined text, but but-
tons and pictures on a web page can also be links.

. Cli the link once. While Firefox locates the link’s page, status messages
will appear at the boom of the window.

Retracing your steps

If you want to visit a page you have seen before, there are several ways to do
so.

‣ To go ba or forward one page, cli the Ba or Forward buon.
‣ To go ba or forward more than one page, cli the small triangles on the

Ba and Forward buons. You should see a list of pages you’ve recently
visited. To return to a page, select it from the list.

‣ To see a list of any URLs you’ve typed into the Location Bar, cli the down
arrow at the right end of the Location Bar. To view a page, select it from the
list.

‣ To oose from pages you’ve visited during the current session, open the
History menu and use the list in the boom section of the menu.

‣ To oose from pages you’ve visited during the past several sessions, open
the History menu and select Show All History. Firefox should open a “Li-
brary” window, whi should a list of folders. Cli the folders to displays
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subfolders, or titles of web pages you’ve visited in the past. Cli a page’s
title to view that page.

Stopping and reloading

If a page is loading too slowly or you no longer wish to view a page, cli the
Stop buon.

To reload the current page or to get the most up-to-date version, cli the
Reload buon or press Ctrl+R.

Opening new windows

At times, you may want to have more than one browsing windows. is may
help you organize your browsing session beer, or separate web pages that you
are viewing for different reasons.

ere are two ways to create a new window:

‣ On the menubar, cli the File menu, then select New Window
‣ Press Ctrl-N

Once a new window has opened, you can use it just like the first window
—including navigation and opening tabs.

Opening a link in a new window

Sometimes, you may want to cli a link to navigate to another web page, but
do not want the original page to close. To do this, you can open the link you’d
like to cli in its own window.

ere are two ways to open a link in its own window:

‣ Right-cli on a link to bring up its popup menu. Select the Open Link in
NewWindow option. A newwindow should open, containing the web page
for the link you clied.

‣ Hold down the Shift key while cliing the link. A new window should
open, containing the web page for the link you clied.

Tabbed browsing

If you would like to visit more than one web page at a time, you can use “Tabbed
Browsing” to navigate the web.

Tabbed browsing lets you open several web pages within a single Firefox
window, ea displaying in its own tab. is frees up space on your desktop
since you don’t have to have awindow open for everyweb page you’re currently
visiting. You can open, close, and reload web pages in one place without having
to swit to another window.
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Opening a new blank tab

ere are three ways to create a new blank tab:

‣ Cli the New Tab buon on the right side of the last tab.
‣ On the menubar, cli the File menu, and then select New Tab.
‣ Press Ctrl+T.

When you create a new tab, it will contain a blank page with the Location
bar focused. Start typing a web address (URL) or other sear term to open a
website in the new tab.

Opening a link in its own tab

Sometimes, you may want to cli on a link to navigate to another web page,
but do not want the original page to close. To do this, you can open the link
you’d like to cli in its own tab.

ere are three ways to open a link in its own tab:

‣ If your mouse has a middle buon, or a wheel, cli on the link with the
middle mouse buon or wheel. A new tab should open, containing the web
page for the link you clied.

‣ Cli on the link with the le mouse buon, and keep holding down the
mouse buon. Drag the link up to a blank space on the tab bar, and release
the mouse buon. A new tab should open, containing the web page for the
link you dragged.

‣ Hold down the Ctrl key while cliing the le mouse buon on the link. A
new tab should oepn, containing the web page for the link you clied.

Closing a tab

Once you are done viewing a web page in a tab, you can close that tab.
ere are three ways to close a tab:

‣ Cli on the Close buon on the right side of the tab you want to close.
‣ On the menubar, cli the File menu, and then select Close Tab.
‣ Cli on the tab you want to close with the middle mouse buon, or the

mouse wheel, if you have one.
‣ Press Ctrl+W

Restoring a closed tab

Sometimes, you have closed the wrong tab by accident, or for another reason
would want to bring ba a tab that you’ve recently closed.

To bring ba a tab you’ve closed:

‣ On the menubar, cli the History menu, select Recently Closed Tabs, and
then select the tab you want to restore.

‣ Press Ctrl+Shift+T to re-open the most recently closed tab.
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Changing the tab order

To move a tab to a different location on the tab bar, drag it there using your
mouse. Cli on the tab with your le mouse buon and hold the mouse buon
as you drag the tab to a new place on the tab bar. While you are dragging the
tab, Firefox will display a small indicator to show where the tab will be moved.

Moving a tab between windows

If you have more than one Firefox window open, you can move an open tab to
a different window. It is also possible to have a tab split off and become its own
window.

To move a tab from one Firefox window to another already open window,
cli on the tab with your le mouse buon, hold down the le mouse buon,
and then drag it to the tab bar on the other Firefox window. When you release
the mouse buon, the tab will be aaed to the new window.

To move a tab from one window into its own window, cli on the tab with
your le mouse buon, hold down the le mouse buon, and then drag the tab
below the tab bar. When you release the mouse buon, the tab will become a
new window.

Searching

You can sear the web, or other collections, from within Firefox without first
visiting the home page of the sear engine.

By default, Firefox will sear the web using the Yahoo sear engine.

Searching the web

To sear the web in Firefox, type a few words into the Firefox Sear Bar.
For example, if you want to find information about the world cup:

. Cli in the Sear Bar.
. Type the phrase “world cup”. Your typing replaces any text currently in the

Sear Bar.
. Hit Enter to sear.

Sear results from Yahoo for “world cup” should appear in the Firefox win-
dow.

Selecting search engines

If you do not want to use Yahoo as your sear engine in the Sear Bar, you
can ange the sear engine that Firefox uses.

To ange the sear engine, cli the icon on the le side of the Sear Bar.
Select one of the other sear engines in the list. Some sear engines, like
Yahoo, sear the whole web; others, like Amazon.com, only sear specific
sites.
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Searching the web for words selected in a web page

Sometimes, you may want to sear for a phrase that appears on a different web
page. Instead of copying and pasting the phrase into the Sear Bar, Firefox
allows you to sear the web for words you select within a web page.

. Highlight any words in a web page using your le mouse buon
. Right-cli on the text you’ve highlighted to display a popup menu. Select

the option Sear [Sear Engine] for “[your selected words]”.

Firefox should open a new tab whi should contain sear results for your
highlighted words using the currently selected sear engine.

Searching within a page

You may want to look for specific text within a web page you are viewing. To
find text within the page you are currently viewing in Firefox:

. Press Ctrl+F or select Edit ‣ Find to open the Find Toolbar at the boom of
Firefox.

. Type the text you want to find into the Find field in the Find Toolbar. e
sear automatically begins as soon as you type something into the field.

. Once some text has been mated on the web page, you can:

‣ CliNext to find text in the page that is below the current cursor position
‣ Cli Previous to find text that is above the current cursor position.
‣ Cli the Highlight all buon to highlight occurrences of your sear

words in the current page.
‣ Select the Mat case field to limit the sear to text that has the same

capitalization as your sear words.

To find the same word or phrase again, press F3 or select Edit ‣ Find Again
from the menubar.

Copying, saving, and printing pages

With Firefox, you can copy part of a page so that you can paste it elsewhere, or
save the page or part of a page as a file on your computer.

Copying part of a page

To copy text from a page:

. Highlight the text with your mouse.
. Select Edit ‣Copy from the menubar.

You can paste the text into other programs.
To copy a link (URL) or an image link from a page:
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. Position the pointer over the link or image.
. Right-cli on the link or image to display a popup menu.
. Choose Copy Link Location or Copy Image Location. If an image is also a

link, you can oose either menu item.

You can paste the link into other programs or into Firefox’s Location Bar.

Saving all or part of a page

To save an entire page in Firefox:

. Select File ‣ Save Page As from the menubar. Firefox should open the “Save
As” window.

. Choose a location for the saved page.
. Type a file name for the page, and cli the Save buon.

To save an image from a page:

. Position the mouse pointer over the image.
. Right-cli on the image to display a popup menu.
. Select Save Image As. Firefox should open the “Save Image” window.
. Choose a location for the saved image.
. Type a file name for the image and cli the Save buon.

Changing your homepage

Bu default, Firefox will show the Ubuntu Start Page when you start Firefox.
If you prefer to display another page when you start Firefox, you will need to
ange your homepage preference.

To ange your homepage:

. Navigate to the page that you would like to become your new homepage.
. Select Edit ‣ Preferences from the menubar.
. In the “Startup” section on the Main tab, whi is shown by default, cli the

Use Current Pages buon. If you had more than one tab open then all the
tabs will be opened when Firefox starts.

. Cli the Close buon

Bookmarks

When browsing the web you may want to come ba to certain web pages again
without having to remember the URL.

In Firefox, you can create Bookmarks, whi are saved in the web browser
and whi you can use to navigate ba to your pied web pages.
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Bookmarking a page

If you have navigated to a web page and would like to bookmark it for future
visits, you will need to add the page as a bookmark.

ere are two ways to bookmark a page:

‣ From the menubar, select Bookmarks and then Bookmark is Page. A
window will open. Provide a descriptive name for the bookmark, and cli
the Done buon.

‣ Press Ctrl+D. A window will open. Provide a descriptive name for the book-
mark, and cli the Done buon.

Navigating to a bookmarked page

To navigate to a bookmarked page, select theBookmarks item from themenubar,
and then cli on your bookmark’s name. Firefox should open the bookmark in
the current tab.

You can also press Ctrl+B to display bookmarks in a sidebar on the le side of
the browser window. Press Ctrl+B again to hide the sidebar

Deleting a bookmark

If you would like to delete a bookmark that you have previously made, select
the Bookmarks item from the menubar, and then right-cli your bookmark’s
name. Firefox should open a popup menu for your bookmark. Select theDelete
option from the menu. Your bookmark should then be deleted.

History

Whenever you are browsing the web, Firefox is saving your browsing history.
is allows you to come ba to a web page that you have previously visited
without needing to remember the page’s URL, or even bookmarking it.

To see your most recent history, select the History item from the menubar.
e menu should then display several of the most recent web pages that you
were viewing. Cli one of the pages to return to it.

To see history from an older time, press Ctrl+H. Firefox should open a “side-
bar” on the le side of the browser window, whi should contain your brows-
ing history categorized as Today, Yesterday, Last  days, is month, and then
monthly for the times before that.

Cli one of the item categories in the sidebar to expand this category, and
see the pages you’ve visited during that time period. en, once you find the
page you need, cli its title to return to it.

You can also sear for a page by its title. Enter a few leers, or a word, in the
Sear field at the top of the history sidebar. e sidebar should then display a
list of web pages whose titles mat your sear words. Cli on the title of the
page you need to return to it.
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If you would like to hide the history sidebar again, press Ctrl+H again.

Clearing private data

Troubleshooting connection problems

Using a different web browser

Reading and composing email

To send and receive email in Ubuntu, you can use the Evolution mail appli-
cation. To start Evolution, open the Applications menu, then oose Internet
and then Evolution Mail.

In addition to email, Evolution also can help manage your contact list, your
calendar, and a list of tasks.

You do not need to use Evolution if you are using a webmail system, su as
Yahoo Mail, Hotmail, or Gmail. To access these services, use the Firefox web
browser to access them on the web.

Running Evolution for the first time

When you start Evolution for the first time, you will need to configure it to
connect to your email account.

When Evolution starts you should see the “Evolution Setup Assistant” win-
dow, welcoming you to Evolution. Cli the Forward buon to continue with
the setup.

Next, on the “Restore from baup” screen, Evolution may ask you to restore
from a previous baup. Since this is the first time you are running Evolution,
you can cli the Forward buon to skip this step.

On the next screen, “Identity”, you need to enter your name and the email
address you wish to use with Evolution. Enter your full name in the Full Name
field, and the full email address in the Email Address field. You can fill in the
optional information, or leave it unanged if you desire. Cli the Forward
buon when you are done.

Next, you should see the “Receiving Email” screen. On this screen, you need
to provide Evolution with the details of your email servers. If you do not know
these details, you will need to ask your network administrator or e with
your email provider.

ere are two common types of internet email connections: IMAP, and POP.
ese are described below. In work environments there are sometimes other
types, su as Microso Exange or Novell GroupWise—for more information
on those types of connections, please see the documentation for Evolution.
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Seing up an IMAP connection

IMAP connections allow you to manage your email remotely—the actual email
and folders reside on your email server, while Evolution allows you to view,
edit, and delete the messages and folders as needed.

If your email provider recommends an IMAP connection, select IMAP in
the Server Type field. In the Server field, enter the internet name of your mail
server. For example, imap.gmx.com. In theUsername field, enter the username
that you use to log into your email system, for example joe.x.user.

Your email provider may specify the security seings you will need to use in
order to receive email. If your connection does not use security, leave the Use
Secure Connection field set to No encryption. Otherwise, select either TLS
encryption or SSL encryption as recommended by your email provider.

Aer selecting these options, cli the Forward buon to proceed to “Re-
ceiving Options” screen. While it is normal to leave all options unselected, you
may want to select the Che for new messages option to have Evolution au-
tomatically e email on a regular basis.

When you are finished seing the options, cli the Forward buon to con-
tinue to the next screen.

Seing up a POP connection

POP connections let you manage your email locally—Evolution will connect to
your email provider and download any new messages you may have received,
and store them in folders on your computer. e messages will be deleted off
the server.

If your email provider recommends an POP connection, select POP in the
Server Type field. In the Server field, enter the internet name of your mail
server. For example, pop.gmx.com. In the Username field, enter the user-
name that you use to log into your email system, for example joe.x.user, or
joe.x.user@gmx.com.

Your email provider may specify the security seings you will need to use in
order to receive email. If your connection does not use security, leave the Use
Secure Connection field set to No encryption. Otherwise, select either TLS
encryption or SSL encryption as recommended by your email provider. Aer
selecting these options, cli Forward to proceed to the next screen.

Aer selecting these options, cli the Forward buon to proceed to “Re-
ceiving Options” screen. While it is normal to leave all options unselected, you
may want to select the Che for new messages option to have Evolution au-
tomatically e email on a regular basis.

You may also wish to adjust the Message Storage options, whi determine
what Evolution does aer downloading email to your computer. Select the
Leave messages on server option to have Evolution keep the messages on your
email system aer downloading them. is will allow you to use another com-
puter to redownload all of your new messages. Select the Delete aer  days
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option to have Evolution keep the messages for a few days, and delete them aer
a while. You can adjust the number of days that Evolution keeps the messages.

When you are finished seing the options, cli the Forward buon to con-
tinue to the next screen.

Seing up your Sending options

e next screen should be the “Sending Email” screen. Here, you will need to
configure your connection for sending email through your email provider.

e most common type of sending connection is SMTP, whi is the default
server type selected.

In the Server field, type in the name of the outboundmail server (also known
as the SMTP server), as described by your email provider. For example,mail.gmx.com.

If your email provider requires authentication, select the Server requires
authentication option. is is common for commercial email providers. In
the “Authentication” section of the screen, select the type of authentication
from the Type field—the most common authentication type is “PLAIN”. Type
your username in below, in the Username field, for example joe.x.user, or
joe.x.user@gmx.com.

Your email provider may specify the security seings you will need to use
in order to send email. If your connection does not use security, leave the Use
Secure Connection field set to No encryption. Otherwise, select either TLS
encryption or SSL encryption as recommended by your email provider.

Aer selecting these options, cli Forward to proceed to the next screen.

Finalizing account options

On the next screen, “Account Management”, enter in a descriptive name for this
account. If you plan to use more than one email provider with Evolution, you
will use this name to distinguish between the different accounts.

When finished, cli the Forward buon. is will bring you to the “Done”
screen. If you believe that you’ve entered the correct options, cli the Apply
buon to finish setup. Otherwise, cli the Ba buon to go ba one or more
screens to correct your seings, or the Cancel buon to abort setup and discard
your account seings.

Aer you finish setup, Evolution may ask you if you would like to make
it your default email client. Cli the Yes buon if you plan on reading and
sending email only with Evolution. Cli the No if you plan on installing or
using a different email program.

Around the Evolution workspace

e Evolution window is divided into four parts. At the top are the menubar
and toolbar. e menubar lets you access most of the functionality of Evolu-
tion, while the toolbar provides some convenient shortcuts to some of the most
frequently used features.
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On the le side of the window is the folder list. Every message that you send
or receive will reside in one of the folders in this list.

Below the folder list on the le side of the window are the Mail, Contacts,
Calendars, Tasks, and Memos buons. When working with email, the Mail
buon is selected. e other buons take you to other parts of Evolution.

On the right side of the window are the message list, and the message pre-
view beneath it. e message list shows all of the messages in the currently
selected folder, or mating your sear request. e message preview shows
the contents of your currently selected message in the list above the preview.

Understanding the folder list

e folder list is the way that Evolution separates and categorizes your email.
e first group of folders in the list is titled “On is Computer”. is set of
folders are you local folders—they reside on your computer only. If you use
POP servers to retrieve your email, any newmessage will be placed in the Inbox
local folder.

You can cli on any folder to see its contents appear in the message list on
the right side of the window.

Ea of the initial folders in the list is special:

‣ Inbox stores your incoming messages.
‣ Dras stores messages that you’ve worked on, but have not yet sent.
‣ Junk stores messages that have been identified as being junk. Junk mail is

also known as “spam”.
‣ Outbox contains messages that you’ve finished composing, but whi have

not been sent yet. For example, if you are working on your email whlie
offline (su as in an airplane), you can still cli the Send buon on an email
message that you finish writing. e message will be moved to the Outbox,
and will remain there until the next time you are able to send and receive
messages. Once you can send and receive messages, all email messages in
the outbox will be sent out.

‣ Sent contains copies of messages that you had sent. Once a message from
an Outbox is sent, it is copied to the Sent folder.

‣ Templates stores email message templates—partial messages that you have
composed and saved as templates. You can use a message stored in the tem-
plate folder as a starting point for other messages.

‣ Trash contains messages that you have deleted. By default, the trash will be
emptied every time you exit Evolution.

If a folder contains any unread messages, the folder’s name will be displayed
in bold, and the number of unread messages will be displayed in parentheses
following the folder name.

If you use an IMAP server to retrieve your email, then your remote IMAP
folders will be shown in the folder list below the “On is Computer” section.
e list of remote folders will be shown with a heading of the name that you
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have given to the account. With IMAP, your email messages will arrive in your
remote Inbox.

Towards the boom of the folder list, Evolution will show a list of “Sear
Folders”. ese are special folders that represent certain messages that mat
sear rules. Please see the section on Finding Messages for more on sear
folders.

Managing folders

In addition to the initial folders, you can create your own folders to manage
your email.

To create a new folder, oose the Folder menu, and then oose New. Type
in a name for the folder that you would like to create. en, from the list of
folders below, select the parent folder. For example, if you would like your new
folder to be placed under the Inbox then select the Inbox folder. If you select “On
is Computer”, then your new folder will be placed under “Onis Computer”
in the folder list.

Once you’vemade your selection, cli theCreate buon to create the folder.
Your new folder should now be in the folder list.

You can move folders that you have created. To do so, cli on the folder
that you would like to move, hold down the mouse buon, and drag the folder
to a new parent folder. Once the mouse cursor highlights a new parent folder,
release the mouse buon to finish the move.

You can also right cli on a folder, and select the Move… option. en,
select the new parent folder, and cli the Move buon.

To delete a folder, right cli on the folder and select the Delete option. To
confirm that you want to delete the folder, cli the Delete buon.

Checking and reading messages

Checking mail

When you finish setup, or when you start Evolution in the future, Evolution
will first try to connect to your email provider to e your email. In order to
connect, Evolution will need to know your email account password, and will
ask you for it.

In the “Enter Password” window, enter your password and cli the “OK”
buon. If you wish for Evolution to remember this password and not ask you
in the future, you can select the Remember this password option.

Evolutionwill then show a “Send and Receive”window, showing the progress
of the operation su as how many messages are being retrieved.
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M I S S I N G S C R E E N S H O T

“enter password” dialog

Figure .: “enter password” dialog

Listing messages

e top right portion of the Evolution window is the message list. Here, you can
see email messages for your currently selected folder, or mating your sear
terms.

By default, the message list shows six columns of information for ea mes-
sage. e first column is a read/unread indicator. If a message has been read,
the column shows an icon of an open envelope. If a message has not been read,
the icon will show a closed envelope.

e second column is an aament indicator. If a message contains an at-
taed file, Evolutionwill show an icon of a paperclip in this column. Otherwise,
the column will be blank.

e third column is an importance indicator. If someone sends you amessage
marked with high importance, Evolution will show an exclamation mark in this
column. Otherwise, this column will be blank.

e fourth column contains the sender of the message. Both the name and
email, or just the email address, may be displayed in this column.

e fih column contains the subject of the email message.
Finally, the sixth column is the date that the email was sent.
When you cli on a message, its contents will be displayed in the preview

pane below the message list. Once you select a message by cliing it, you can
cli the Reply buon in the toolbar to begin composing a reply message to be
sent to the sender, or cli the Reply to All buon to begin composing a reply
message to be sent to the sender and other recepients of your selected message.

You can also cli the Trash buon in the toolbar in order to put the message
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Small view of the message list, showing column headers and a few email messages

Figure .: Small view of the message list,
showing column headers and a few email
messages

in the Trash folder, or the Junk buon to put the message as in the Junk folder.
Note that Evolution, or your mail server, may automatically classify some mail
as Junk.

In addition to the buons on the toolbar, you can right cli a message in
the list. Evolution will open a menu with actions that you can perform for the
message.

Sometimes, you may wish to take an action on multiple email messages (for
example, delete multiple messages, or forward them to a new recepient). You
can do this in Evolution by holding down the Ctrl key while cliing multiple
messages—the messages you cli will be selected. You can also cli one mes-
sage to select it, then press and hold the Shift key and cli on another message
in the list. All messages in the list between the original selection and the one
you just clied will be selected. Once you have multiple messages selected,
right cli on one of them to perform your desired action.

Directly above the message list are the Show selector, and the sear options.
You can use the Show options to filter your view to show only unread messages,
or only messages with aaments, etc.

e sear options will be covered in a later section.

Previewing messages

When you select an email message, its contents will be shown in the preview
pane below the message list.

e top of the preview pane will show the message header, whi contains
the sender, recepients, and subject of themessage, aswell as the date themessage
was sent. Below the header, Evolution shows the contents of the message itself.
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If a message was sent with HTML formaing, some of the images may not be
displayed when a message is previewed. To display the missing images, select
View from the menubar, then Load Images, or press Ctrl+I. If your internet
connection is active, the missing images should then load. Note that loading images may provide a way

for the sender to track your receipt of the
message. We do not recommend loading im-
ages in messages that you suspect are Junk.Opening messages

At times, you may want to display multiple messages at the same time. To do
so, you can open ea message in a separate window instead of just viewing it
in the preview pane.

e open amessage in its ownwindow, double cli amessage in themessage
list. e message should then open in a separate window. You can go ba to
the message list and open another message, if needed.

In the open message window, you can use the options in the menubar or on
the toolbar to reply to the message, categorize it, delete it, as well as perform
other message actions.

Finding messages

ere are three ways to sear for messages in Evolution: you can use the sear
option at the top of the message list, use the Advanced Sear function, or create
a sear folder.

To use message list sear, enter the text you want to find in the Sear field
at the top right of the message list, and press Enter. e list of messages will
ange to show only those messages containing the text you entered.

To the right of the sear field you should be able to see a drop down list of
options su as “Current Folder”, “Current Account”, and “All Accounts”. By
default, Evolution will use the “Current Folder” option and will only show you
results within the folder you’ve got selected in the folder list on your le. If
you oose the “Current Account” option, Evolution will sear for messages
in all folders within the current email account—su as all the folders “On is
Computer” or in your IMAP folders, depending on your email setup. If you have
multiple email accounts added to Evolution, oosing “All Accounts” option lets
you sear for messages in all of your accounts.

If no messages mat the text you’ve entered, you can edit the text and
try searing again. To return to the folder display, oose Sear from the
menubar and then oose Clear, or instead erase all the text you’ve entered in
the Sear field and press Enter.

In some cases, you may want to sear for messages using multiple criteria.
For example, you may want to find a message from a particular user with some
specific words in the subject of the message. In Evolution, you can perform this
sear using the Advanced Sear function.

To useAdvanced Sear,oose Sear ‣Advanced Sear. Evolution should
open the “Advanced Sear” window. In the middle section of the window,
specify your sear criteria. For our example, to findmessages frommyfriend@example.com
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that contained “boat” in the subject, you would enter myfriend@example.com
in the text field to the right of the drop down list with “Sender” selected, and
would enter boat in the text field to the right of the drop down list with “Sub-
ject” selected. en, cli on Remove to the right of all lines that are unused,
and cli OK to perform the sear. e message list should then only display
messages that mat your advanced sear criteria.

When specifying the criteria for advanced sear, you can use the Add Con-
dition buon to add additional lines. You can also ange the selection in the
drop down list at the beginning of ea line to specify a different field to be
eed, or ange the drop down with “contains” selected by default in order
to have a different type of a mat. Please refer to the Evolution help documents
for more information.

In some cases, you may want to perform the same sear request on a reg-
ular basis. For example, you may want to always be able to see all messages
from myfriend@example.com regardless of whi folder you’ve used to store
the message. To help with this type of a sear, Evolution allows you to create
Sear Folders.

To create a sear folder, oose Sear ‣Create Sear Folder From Sear
from the menubar. Give the folder a name by entering it in the Rule name field
at the top. en, specify sear criteria in the same way as in Advaned Sear.
Below the criteria, pi whi folders should be seared by this sear folder
—for example, you can oose “All local and active remote folders” to sear in
all of your account’s folders. When you are finished, cli OK.

e new sear folder should now be added to the list of sear folders to-
wards the boom of the message list. If you cli on the sear folder to select
it, you should be able to see a list of messages that mat your sear criteria.

Subscribing to IMAP folders

If you use IMAP to retrieve your email, you should see a set of folders in the
folder list on the le side of the window that is titled with the name of your
IMAP account. Folders like Inbox, Dras, Junk and others should be displayed
in the folder list.

If you have other folders in your IMAP account, you will need to subscribe
to them. If you subscribe to a folder, Evolution will download messages for that
folder whenever you e your email.

To subscribe to a folder select Folder ‣ Subscriptions from the menubar.
Evolution should open the “Folder Subscriptions” window. From the Server
drop down list oose your account name. Evolution should then show a list of
folders in the list below.

Choose the folders you would like to subscribe to by selecting the e box
to the le of the folder name. When you are finished, cli Close. e folders
will be updated the next time you e your email.
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Composing and replying to messages

In addition to reading email, you will likely want to reply to the email you read,
or compose new messages.

Composing new messages

To compose a new message, cli the New buon on the toolbar. Evolution
should open a “Compose message” window.

In the To: field, enter the email address of the destination—the contact to
whom you are sending this email. If there is more than one contact to whom
you are writing, separate multiple recipients with commas.

If a contact that you are addressing is in your address book, you can address
them by name. Start typing the name of the contact; Evolution will display the
list of mating contacts below your text. Once you see the contact you intend
to address, cli their email address or use the down arrow key and then Enter

to select the address.
If you would like to carbon-copy some contacts, enter their email addresses

in the Cc: field in the same manner as the To: recipients. Contacts on the To:
and Cc: lines will receive the email, and will see the rest of the contacts to whom
an email was sent.

If you would like to send an email to some contacts without disclosing to
whom your email was sent, you can send a blind carbon-copy, or “Bcc”. To
enable Bcc, select View ‣Bcc Field from the menubar. A Bcc: field should
appear below the Cc: field. Any contacts entered in the Bcc field will receive
the message, but none of the recipients will see the names or emails of contacts
on the Bcc line.

Instead of typing the email addresses, or names, of the contacts you are ad-
dressing in themessage, you can also select the contacts from your address book.
To do so, cli the To:, Cc: or Bcc: buons to the le of the text fields. Evolution
should open the “Select Contacts from Address Book” window. Use the list on
the le side of the window to oose your contact, or type a few leers from
your contact’s first or last name in the Sear field to filter the list to only show
mating contacts.

Once you identify the contact you would like to address, cli their name in
the list. en, cli the Add buon to the le of either the “To:”, “Cc:”, or “Bcc:”
fields on the right of the screen. Your osen contact will be added to that list.
If you’ve added the contact in error, cli their name in the list on the right, and
cli the Remove buon. When you are finished piing contacts, cli Close
to return to the composing screen.

Enter a subject for your email. Messages should have a subject to help the
recepient to identify the email while glancing at their message list; if you do not
include a subject, Evolution will warn you about this.

Enter the contents of your message in the big text field below the subject.
ere is no practical limit on the amount of text you can include in your mes-
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sage.
By default, new messages will be sent in “Plain Text” mode. is means that

no formaing or graphics will be shown to the recepient, but themessage is least
likely to be rejected or displayed illegibly to the receipients. If you know that
your recipient uses a contemporary computer and a modern email program,
you can send them messags that include formaing. To swit to this mode,
cli the drop down list buon on the le side directly above the text field for
the message contents. Change the selection from “Plain Text” to “HTML” to
enable advanced formaing. When using HTML mode, a new toolbar should
appear right under the mode selection that will allow you to perform advanced
advanced font styling and message formaing.

When you have finished composing your email, cli the Send buon on the
window’s toolbar. Your message will be placed in the Outbox, and will be sent
when you next e your email.

Aaching files

At times, you may want to send files to your contacts. To send files, you will
need to aa them to your email message.

To aa a file to an email you are composing, cli on the Add Attament
buon at the boom right of the email message window. Evolution should show
the “Add aament” window.

Select the file you would like to include in your message and cli on the
Atta buon. Evolution will return you to the email message window, and
your selected file should be listed in a section below Add Attament buon.

Replying to messages

In addition to composing new messages, you may want to reply to messages
that you receive.

ere are three types of email replies:

‣ Reply (or “Reply to Sender”)—sends your reply only to the sender of the
message to whi you are replying.

‣ Reply to All—sends your reply to the sender of the message, as well as any-
one else on the To or Cc lines.

‣ Forward—allows you to send the message, with any additional comments
you may add, to some other contacts.

To use any of these methods, cli on the message to whi you want to reply
and then cli the Reply, Reply to All, or Forward buon on the toolbar.

Evolution should open the replywindow. iswindow should lookmu like
the window for composing new messages, but the To, Cc, Subject, and main
message content fields should be filled in from the message to whi you are
replying. Ea line in the message should be prefixed with a “>” aracter.
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Edit the To, Cc, Bcc, Subject or main body as you see fit. When your reply is
finished, cli on the Send buon on the toolbar. Your message will be placed
in the Outbox, and will be sent when you next e your email.

Using signatures

In order to give your messages a footer, Evolution allows you to use a “signa-
ture”. Signatures in email are a bit of standard text that is added to the boom
of any new messages or replies.

When composing of replying to a message, cli on the Signature drop down
list below the toolbar just above the To: field. is list should contain any
signatures that you have created, as well as an “Autogenerated” signature. If
you select Autogenerated, Evolution will add two dashes, and then your name
and email address to the boom of the email message.

You can also specify some custom signatures. To create a signature, open
the “Evolution Preferences” window by selecting Edit ‣ Preferences from the
menubar. On the le side of the Evolution Preferences window, select Com-
poser Preferences and then select the Signatures tab.

Cli on the Add to add a new signature. Evolution should then open the
“Edit Signature” window. Give your signature a name, and enter the contents
of your signature in the big text field below. When finished, cli on the Save
buon on the toolbar (the buon’s icon looks like a floppy disk). Your new
signature’s name should appear in the list in preferences. Close the preferences
window. Note that the two dashes are added automati-

cally by Ubuntu, so there is no need to include
them in your custom signature

Your signature should now show up in the drop down list in the compose/re-
ply window.

Staying organized

e Evolution application in Ubuntu can let you keep and manage a list of your
contacts, maintain a calendar, and a task list.

If you have already set up Evolution with an email account, you do not need
to do any further setup to use these features. If you do not wish to use Evolu-
tion for email, you can still use it for managing your contacts or maintaining
a sedule, as well as keep tra of tasks and memos that you can create for
yourself.

To start Evolution, open the Applications menu, then oose Internet and
then Evolution Mail.

Managing your contacts

If you would like to keep a list of your contacts—personal or professional contact
information for people and organizations—you can manage these contacts in
Evolution.

To view contacts, cli on the Contacts buon below the folder list on the



working with ubuntu 

le side of the Evolution window. e folder list on the le will be replaced by
a list of address book types. Cli on an address book, for example “Personal”.

e right side of the window will display a list of contacts. Cli a contact to
show the contact’s details in the lower portion of the right side of the window. An address book is a collection of contacts

and contact lists. It can either be stored on
your computer, or on a remote server.

If you use Ubuntu One, you may have two address books—a “Personal” ad-
dress book stored on your computer, and an “Ubuntu One” address book. You
can add contacts to either address book, though only the “Ubuntu One” address
book is synronized to your Ubuntu One account.

Searching for contacts

To find a contact, type in a few a few leers from the contact’s first or last name
in the sear text box on the upper right of the window, and press Enter. e list
below should ange to only show contacts whose name mates your sear
term.

Adding or editing a contact

To make anges to an existing contact, find the contact in the list and double-
cli on the entry. Evolution should open a “Contact Editor” window for the
contact.

Swit between the different tabs in the contact editor to make anges to
the contact. Cli OK when you have finished making your anges.

To add a new contact, cli the New on the toolbar. Evolution should open
the “Contact Editor” window. Enter the contact’s details in the contact editor
window, and cli OK when finished.

Managing your schedule

If you like to manage your sedule with a computer, you can maintain this
sedule in Ubuntu using Evolution.

To view your calendar, cli on theCalendars buon below the folder list on
the le side of the Evolution window. e folder list on the le will be replaced
by a list of calendars, and a mini-calendar showing the current month.

Evolution allows you to manage more than one calendar. For example, you
could have a personal calendar and a sool or work calendar. You can also
subscribe to the calendar of a friend or family member who mayoose to share
their calendar with you.

Cli on one of the calendars in the list. By default, you should have a “Per-
sonal” calendar in the list. e middle of the window should now show a view
of the current day, showing all the hours of the current day.

If the calendar already has some events, Evolution will show the event in the
day view between the hours when the event starts and finishes. You can double-
cli on the event to open its details, or drag the event to a different time or date
to resedule it.
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In the day view, you can cli on a different day on the mini-calendar on the
le side of the screen. Evolution will then display that day in the day view.

You may also wish to see more than one day at a time. is will allow you
to compare sedules on different days, or find a free day for an event you wish
to sedule. In Evolution, you can cli on the Work Week or Week buons
on the toolbar to see an entire week at the same time. Cli the Month buon
on the toolbar to see a view of the entire month—if an event is difficult to read
due to the small space aloed to ea day, you can hover your mouse over the
event to have Evolution show the full title of the event. Finally, the List buon
on the toolbar shows upcoming appointments in a list, allowing you to see all
of your upcoming appointments at a glance.

On the right side of the window, Evolution displays a list of tasks andmemos.
You can add a new task or memo to Evolution

Adding a new event

e simplest way to add a new task is to cli a time in the day view, and begin
typing. An event “bubble” will appear, containing the text that you are typing.
If you want to add a longer event, drag your mouse from the first time slot to
the last before starting to type.

M I S S I N G S C R E E N S H O T

visual example of adding an event in the day view by typing

Figure .: visual example of adding an event
in the day view by typing

To add a new event without using the day view, cli on the New buon on
the toolbar. Evolution should open the “Appointment” window. In the Sum-
mary field, enter a short title for the event as you want it to appear on the
calendar. Optionally specify the location and enter a longer description if you
would like. Make sure that the time and date, as well as the duration, are as you
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want them. Finally, cli on the Save buon on the toolbar to save this new
event (the buon looks like a floppy disk, and is the first buon on the toolbar).

Scheduling a meeting

If you would like to sedule a meeting with one of your contacts, Evolution
can assist you in sending out an invitation and processing replies.

To create ameeting invitation,oose File ‣New ‣Meeting from themenubar.
Specify the subject, location, time and duration, and description as when you
create a regular event.

You will then need to add aendees to this meeting. To add an aendee, cli
on the Add buon. In the list of aendees, Evolution will add a new row—type
the aendee’s email address or contact name.

When you are finished adding aendees, cli on the Save buon on the
toolbar. Evolution should then ask you if you would like to send meeting invi-
tations to your selected participants. Cli Send to send out these invitations.
e invitations will be sent the next time you e email in Evolution.

If your contact ooses to reply to the meeting invitation, Evolution will
show you a new email message. In the body of the email message, Evolution
will display an Update Attendee Status buon. Cli on that buon to mark
your contact as aending the meeting.

Using instant messaging

Instant messaging allows you to communicate with people you know in real
time. Ubuntu includes the Empathy application that lets you use instant mes-
saging features to keep in tou with your contacts. To start Empathy, cli
Applications from the menubar, then oose Internet and then Empathy IM
Client.

Empathy lets you connect to many instant messaging networks. You can
connect to AIM™, Gadugadu, Google Talk, Groupwise, ICQ®, Jabber®, MSN®,
Myspace®, qq®, XMPP™, Sametime®, Silc, SIP, Yahoo®, or Zephyr.

Running Empathy for the first time

When you open Empathy for the first time you will need to configure it with
the details of your instant messaging accounts.

When Empathy starts youwill see the “Welcome to Empathy”window. Choose
the option corresponding to your situation.

You have an account

If you have an account that you have used previously with another instant mes-
saging program then select the Yes, I’ll enter my account details now option.
en, cli the Forward buon to continue.
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M I S S I N G S C R E E N S H O T

Main Empathy window

Figure .: Main Empathy window

On the next screen, oose your account type from the drop down box below
What kind of at account do you have?. en, enter your account details in
the field below.

Depending on the account type that you oose, Empathy may request that
you enter a username, or an ID for your account, followed by a password.

Figure .: Creating a new instantmessenger
account in Empathy.

If you do not remember your account information, you will need to visit the
website of the instant messaging network to retrieve that information.

If you have another account to add then select the Yes option, and cli the
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Forward buon to repeat the above process. When you have entered all the
accounts leave the No, that’s all for now option selected, and cli the Apply
buon to finish the setup process.

Next, Empathy should display the “Please enter personal details” screen. If
you oose to fill out this information, you will be able to communicate with
people who are on your local network either at home or in an office.

Enter your first name in the First name field, and your last name in the Last
name field. Type in a way that you would like to be identified on your local
network in the Niname field. When you have filled all of the information,
cli the Apply buon.

If you don’t want to communicate with people on your local network, select
the I don’t want to enable this feature for now option and cli the Apply
buon.

You would like an account

If you don’t have an account that you can use, then you can create one by
selecting the No, I want a new account option. Cli the Forward buon to
display the next set of options.

Choose the account type that you would like to create from the drop down
below What kind of at account do you want to create? You can create
either a Jabber® or a Google Talk account. Note: If you wish to create another account

type then you will need to visit the relevant
website and follow the “You have an account”
section.

Next, enter the account name that you would like in the text field, and in the
proceeding text field enter a password of your oice. If you would like to set
up another account then select the Yes option, and repeat the above process.

When you have entered all the accounts leave the No, that’s all for now
option selected, and cli the Forward buon.

Empathy should display the “Please enter personal details” window. Provid-
ing this information allows you to communicate with people who are on your
local network either at home or in the workplace.

Enter your First name in the text field, and enter your Last name in the next
field. In the Niname field enter a niname by whi you would like to be
identified. When you have filled all of the text fields cli the Apply buon to
save your seings.

If you don’t want to talk to people on your local network then select the I
don’t want to enable this feature for now option and cli the Apply buon.

You want to talk to people nearby

If you would only like to communicate with people on your local network either
at home or in the workplace, then you should select the No, I just want to see
people on-line nearby for now option.

Cli the Forward buon to display the next set of options. en enter your
First name in the text field, and enter your Last name in the next field. In
the Niname field enter a niname by whi you would like to be identified.
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When you have filled all of the text fields, cli the Forward buon.

M I S S I N G S C R E E N S H O T

Enter details window for seing up talking to people nearby

Figure .: Enter details window for seing
up talking to people nearby

Changing account seings

If you need to add more accounts aer the first laun, then cli the Edit then
Accounts. Empathy will then display the “Accounts” window.

Adding an account

To add and account cli the Add buon. Empathy should display some op-
tions on the right hand side of the window. Choose your account type from the
Protocol drop down. Next, enter your account name in the first text field. en
enter your password in the Password text field. Finally cli the Log in buon
to save and verify your seings.

Editing an account

You might need to edit and account if you ange the password or get the pass-
word wrong. Select the account you want to ange on the le side of the “Ac-
counts” window. Empathy should show the current seings for the account.
Once you have made your anges, cli the Save buon.

Removing an account

To remove an account select the account on the le hand side of the window and
cli the Remove buon. Empathy should open the “Do you want to remove”
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window. Cli the Remove buon to confirm that you want to remove the
account, or the Cancel buon to keep the account.

Editing contacts

Adding a contact

To add an account cli the Chat menu, then cli Add contact, this opens the
“New Contact” window.

In the Account dropdown oose the account that you want to add the con-
tact to. Your must add you contact to an account type that mated theirs.

For example if your contact’s address ends in “@googlemail.com” then you
will need to add it to an account that ends in “@googlemail.com”. Likewise if
the contact’s e-mail ends in “@hotmail.com” then you would need to add it to
an account ending in “@hotmail.com”.

When you have osen the account that you wish to add the contact to, you
will need to add either their login id, username, screen name or e-mail address
to the Identifier text field.

en in the Alias text field enter the contacts name as you would like to see
it in your contact list. Cli the Add buon to add the contact to your list of
contacts.

Removing a contact

Cli the contact that you want to remove and then cli the Edit menu, then
cliContact, then cliRemove. is will open the “Remove contact” window.

Cli the Remove buon to confirm that you want to remove a contact, or
cli the Cancel buon to keep the contact.

Communicating with contacts

Text

To communicate with a contact, oose the contact in Empathy’s main window
and double cli their name. Empathy should open a new window where you
can type messages to your contact, and see a record of previously exanged
messages.

To send a message to the contact, type your message in the text field below
the conversation history.

When you have typed your message press the Enter key to send the message
to your contact. If you are talking to more than one person then all of the
conversations will be shown in tabs within the same window.

Audio

If your contact has audio capabilities then there will be an icon of a microphone
next to their name. Cli the microphone icon to open a menu. Select theAudio
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call option from the menu. Empathy should then open the “Call” window.
is window shows your picture on the right and your contact’s picture on

the le. Ensure that your microphone and speakers are connected, and proceed
with the audio conversation. You can finish the conversation by pressing the
Hang up buon.

Video

If your contact has videoat capabilities then there will be an icon of a webcam
next to their name. Cli the icon to open a menu. Select the Video call option
from the menu. Empathy should then open the “Call” window.

is window shows your webcam view in the top right and your contact’s
webcam will be in the middle.

If you don’t have a webcam then your picture will be shown instead. You
can finish the call by oosing the Hang up buon.

Sending and receiving files

Sending a file

When you are in a conversation with a contact and you would like to send them
a file, cli the Contact menu and then cli Send file.

Empathy should open the “Select file” window. Find the file that you wish to
send and cli the Send buon. A “File Transfers” window will open showing
the osen file and its transfer progress.

When the file transfer is complete, you can close the “File Transfers” window.

Receiving a file

When a contact wants to send you a file, the status icon to the le of the contact’s
name will flash with an icon of a paper plane.

To receive the file double cli the contacts name. Empathy will open the
“Select a destination” window. Choose a location where you would like Empa-
thy to save the file, and cli the Save buon. Empathy should open the “File
Transfers” window.

e “File Transfers” window shows you the progress of current file transfers.
You can stop file transfers by cliing the Stop buon, open transferred files by
cliing the Open buon, and clear the list of completed transfers by oosing
the Clear buon.

Changing your status

You can use your status to show your contacts how busy you are or what you
are doing. You can use the standard statuses, whi are “Available”, “Busy”,
“Invisible” and “Off-line”. ese can be anged in the main Empathy window
from the drop down at the top of the window.
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e same drop down lets you set a custom status by oosing “Custom Mes-
sage…” next to the icon thats mates your status. Type what you would like
your status to say, and cli the green ti.

Changing your picture

Your picture is what your contacts will see next to your name in their contact
list. e default picture is the outline of a person. You can ange your picture
by oosing the Edit menu, then oosing Personal Information.

Emapthy should open the “Personal Information” window. From the Ac-
count drop down oose the account that you want to ange, then cli the
picture on the right hand side of the window.

Empathy should open the “Select Your Avatar Image” window. Find the file
cotnaining your picture, and cli the Open buon. If you would like to return
it to the default cli the No Image buon instead.

Viewing and editing photos

To view and edit photos you can use a program called F-spot this can be found by
cliing the Applications menu, then Graphics, then F-spot Photo Manager.
When you laun F-spot for the first time you will see the “Import” window,
how to use this is covered in ’Importing’.

F-spot displays your photos by date you can view photos from a specific
month by cliing that month in the time line near the top of the window.

You can play slide shows of your pictures by cliing the green play triangle.

A lot of this guide refers to the side bar on the le if you can’t see it cli the
View, then cli Componets and oose Sidebar making sure the option box is
selected.

Version system

So when you edit a photo F-spot creates a new version so that the original is
not lost. You can create a new version by cliing the Photo menu, then Create
New Version…. is opens the “Create New Version” window. In the Name
text field you can type what you would like to call the version and then cli
the OK buon. A new version will have been created.

You can view previous versions by cliing the photo that you wish to view
then cliing the Edit Image buon. is anges the side bar on the le to the
“Edit” side bar. In the boom le the Version drop down allows you to oose
previous versions of the photo.

You might want to rename a version so that you remember whi version is
whi. To rename a version cli the photo that you want to ange, then cli
the Edit Image buon. is anges the side bar on the le to the “Edit” side
bar. In the boom le the Version drop down oose the version of the photo
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Figure .: F-Spot let’s you store, tag, and
edit your photos.
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that you want to rename. en cli the Photo, then cli Rename Version,
this will open the “Rename Version” window. Enter the new name in the New
name text field, then if you want to rename the version cli the OK buon, if
you don’t want to rename the version cli the Cancel buon.

If when editing photos you may make a mistake and want to remove that
version as you don’t need it. To delete a version cli the photo that you want
to ange, then cli the Edit Image buon. is anges the side bar on the
le to the “Edit” side bar. In the boom le the Version drop down oose
the version of the photo that you want to delete. en cli the Photo, then
cli Delete Version, this will open the “Really Delete?” window. If you want
to delete the version cli the Delete buon, if you don’t want to delete the
version cli the Cancel buon.

Importing

When you laun F-spot for the first time you will see the “Import” window.
Aer the first laun you can import more photos by cliing the Import buon.

When you import only the photos that you have just imported are shown to
show all of your photos cli the grey Xto the right of the blue Find.

Where f-spot save photos

When importing pictures in the “Import” the Copy files to the Photos folder
depends on where the photos are saved.

If the Copy files to the Photos folder option is tied then F-spot will copy
the photos into the Photos folder whi is within the Pictures folder. e pic-
tures are then sorted by year, month and then date.

If the Copy files to the Photos folder option is un-tied then F-spot will
not copy the pictures into the Photos folder.

From file

To import photos that are saved on you computer cli Select Folder from the
Import Source drop down. is gives you the “Import” window, in this window
navigate to the folder that the photos are in and cli the Open buon.

When the loading bar says “Done Loading” all the photos in that folder and
any sub-folders are then displayed in the “Import” window. You can exclude
importing photos from sub-folders buy cliing the Include subfolders option
so that the option is un-tied.

All of the photos are imported by default, but you can oose individual
photos by holding down the Ctrl key. Duplicates are automatically detected
when the Detect duplicates option is selected.

You can aa tags by typing the names of the your current tags in theAtta
Tags text field. If you want to use multiple tags then separate them with a
comma.
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Once you have osen the photos that you want import cli the Import
buon.

From digital camera

Plug your camera into the computer and turn the camera on a new window
should pop up, e that Open F-spot is shown in the drop down and cli the
OK buon. is will show the “Import” window, in the Import Source drop
down cli the option that looks like …Camera.

A “Select Photos to Copy from Camera…” window will open, you can then
cli the photos that you want to copy. All of the photos are selected by default
but you can add or remove individual photos by holding the Ctrl key.

You can aa tags to all of them by cliing the Atta tag option and
oosing the tag in the Atta tag: drop down. For more information about
tags see “Organizing photos”

You can ange where the files are saved in the Target location drop down.
e default is the Photos folder, this is where F-Spot saves the pictures.

Once you have osen the pictures that you want to import cli the Copy
buon.e “Transferring Pictures”window opens and shows the copying progress,
when the copying is complete the progress bar will say Download Complete.
Fianly Cli the OK buon to show the pictures in F-spot

Organizing photos

F-Spot makes finding photos of the same type easier by using tags, you can apply
as many tags to a photo as you like.

You can apply tags to photos by selecting the photos and then right cli and
move the mouse to Atta Tag and cli the tag you want add. You can aa
tags when importing photos this is covered in the “Importing” section.

You can make new tags by cliing the Tags and cliing Create New Tag….
is will open up the “Create New Tag” window, type the name of the tag in
the Name of New Tag: text field. e Parent Tag: drop down allows you to
oose the tag that it is a sub-tag of.

Editing Images

A photo might want to be edited to remove; something at the edge, discoloring,
red-eye’s or straighten a photo. To edit a photo cli the one that you want
to edit and then cli the Edit Image buon. is anges the side panel on
the le of the “F-Spot” window. e panel shows eight options Crop, Red-
eye Reduction, De-saturate, Sepia Tone, Straighten, So Focus, Auto Color,
Adjust Colors. Some of these options are explained in more detail in the next
section.
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Crop

You might want to crop a photo to ange the framing or remove part of the
edge of the photo. Cli the Crop on the le panel, then in the Select an area
to crop drop down you can oose the ratio that you would like to crop with.
You might want oose the ratio that mates the ratio that you print, so that
the photo is not streted.

You can create custom constraints if one of the defaults does not meet your
requirements. is is done by oosing Custom Ratios from the Select an area
to crop drop down. is gives you the “Selection Constraints” window, cli
add this will place a new entry on the le of the window.

Once you have osen your constraint, move the cursor to one conner of the
section that you want to keep. Cli and hold the le mouse buon and drag it
to the opposite corner of the section that you want to keep. You can then let go
of the mouse buon.

To resize the box move the mouse until an arrow points to the side that you
want to move. Cli and hold the le mouse buon, move the mouse until the
edge is in the right place.

All ratios work in portrait and landscape mode, to ange between you need
to cli the edge as if you were to resize the box. Moving the cursor between
top right and boom le swites between portrait and landscape.

Red-eye Reduction

If you have taken a photo and the flash caused the subject to have red-eye’s
this can be removed by first cliing the Red-eye Reduction buon. Move the
cursor to the one corner of the subjects eye and hold the le mouse buon, then
drag the cursor to the opposite corner and let go of the mouse buon.

is box can be moved by moving the cursor into the middle until a hand is
shown, then cli and hold the le mouse buon and move it into the correct
place. When it is in the correct place you can let go of the le mouse buon.

To resize the box move the mouse until an arrow points to the side that you
want to move. Cli and hold the le mouse buon, move the mouse until the
edge is in the right place.

When the box covers all of the red in one eye cli the Fix. You will need to
repeat the process for ea of the subject’s eyes that is effected. and a

Straighten

If you have a photo that you took an is at an angle then the cli the Straighten
buon. en move the slider until the picture is straight again. F-Spot will auto
crop the picture to remove any white parts that occur due to the rotation. When
you are happy that the picture is straight then cli the Straighten buon.
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Auto Color

To automatically correct the coloring of the photo cli the Auto Color buon.

Exporting to web services

F-spot allows you to export you photos to a Web Gallery, Folder or CD and the
following services; SmugMug©, PicasaWeb™, Flir™, hq and Zooomr™.

You can export to these services by oosing a picture and then cliing
Photo the Export to and cli the service that you require. is will open a
window in whi you can enter your account name and password, then you
will be able to upload pictures.

Watching videos and movies

You can play videos and dvds, cli Applications, then cli Sound & Video,
then cli Movie Player. is will open the “Movie Player” window.

Figure .: Totem plays music and videos.
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Codecs

Legal Notice Patent and copyright laws operate differently depending on whi
country you are in. Please obtain legal advice if you are unsure whether a
particular patent or restriction applies to a media format you wish to use in
your country.

So that you can play all videos and dvds you will need to install some codecs,
this is done by enabling theMultiverse repositories for how to do this see Chap-
ter : Soware and Paaging.

Once you have enabled the repositories, cli Applications then Ubuntu
Soware Centre. When the “Ubuntu Soware Centre” window opens use the
sear box in the top right and sear for the following “gstreamer.-ffmpeg,”
“gstreamer.-plugins-bad,” “gstreamer.-plugins-ugly,” “gstreamer.-plugins-
base,” “gstreamer.-plugins-good,” “libdvdread” and “libdvdnav,” “libdvd-
css.”

When you find ea one cli it and then if there is an Install buon cli it, if
there is a Remove buon then it is already installed. Cliing the Install buon
may open the “Authenticate” window, enter you passowrd in the Password text
feild. Once you have entered your password cli theAuthenticate buon, this
will start the installation. For more information on the terminal see

Chapter : The command-lineYou also need to run a command, cli Applications then cli Accessories
then cli Terminal. is will open the “Terminal” window, then type the com-
mand as shown below.

$ sudo /usr/share/doc/libdvdread4/install-css.sh

Once you have typed the command, press the enter/return key. You may be
asked for your password to authorise this type in you password and press the
enter/return key and wait for it to finish. Once it has finished you can close the
“Terminal” window.

Playing videos from file

Cli Movie, then cli Open…, this will show the “Select Movies or Playlists”
window. Find the file(s) that you want to play and cli the Add buon. e
video(s) will start playing straight away.

Playing a dvd

When you insert a dvd in the computer the “You have just inserted a Video
DVD. Choose what application to laun” window will show. Make sure that
Open Movie Player is shown in the drop down and then cli the OK buon.
e “Movie Player” window will open and the movie will start.

If the “Movie Player” window is already open, cli Movie, then cli Play
Disc …. and the movie will start.
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Listening to audio and music

Working with documents, spreadsheets, and presentations

ite oen, you may need to use your computer for work. You may have a
need to use a word processor to write a document. You may need to work on a
spreadsheet, do calculations on a table of data or create a data art. You may
want to work on slides for a presentation.

In Ubuntu, you can use the OpenOffice.org suite of applications for these
tasks.

Working with documents

If you need to work with documents, you can use the OpenOffice.org Word
Processor. To start the word processor, open the Applications menu, oose
Office, and then oose OpenOffice.org Word Processor. Ubuntu should then
open the main window for the word processor. . The OpenOffice.org Word Processor is

also known as the OpenOffice.org Writer.
Spreadsheet is also known as Calc, and
Presentation is known as Impress.Working with spreadsheets

If you need to work with spreadsheets, you can use the OpenOffice.org Spread-
sheet. To start the spreadsheet application, open theApplicationsmenu, oose
Office, and then oose OpenOffice.org Spreadsheet.

Working with presentations

If you need to work with slides for a presentation, you can use the OpenOf-
fice.org Presentation. To start the presentation application, open the Applica-
tions menu, oose Office, and then oose OpenOffice.org Presentation.

Geing more help

Ea of these applications comes with a comprehensive set of help screens. If
you are looking for more assistance with these applications, press the F1 key
aer starting the application.

Taking notes

You can take notes in a program called Tomboy Notes, you can use it to make
a shopping or a to do list. Cli Applications, then cli Accessories and cli
Tomboy Notes

You can sear all of your notes by typing a word in the Sear: text field in
the main tomboy window.
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M I S S I N G S C R E E N S H O T

Screenshot of main Tomboy window

Figure .: Screenshot of main Tomboy win-
dow

Making notes

To create a new note cli File, then cli New, the “New Note” window will
open.

e “New Note” window will contain a blue title “New Note” this can be
deleted and anged to a title that makes the note more memorable. e main
content of the note can be typed where it says “Describe your new note here.”
Once you have entered your text just close your note as all anges are auto-
matically saved.

To delete the note cli the red delete note buon, this will open a “Really
delete this note?” window. If you do want to delete the note cli the Delete
buon, otherwise cli the Cancel buon.

You can add a note to a notebook by cliing theNotebook buon and cli-
ing the option next to the notebook that you want to move the note to.

Organizing notes

You can organize your notes in Tomboy using “Notebooks,” is makes finding
you notes quier and in a more logical location. To create a new note book
cli File, then Notebooks, and cli New Notebook….

e “Create a new notebook” window will open, type the name of the note-
book in the Notebook name: text field. Once you have typed the notebook
name cli the Create buon.

e notebook will now show up in the sidebar of Tomboy Notes. You can
cli and hold on the note of your oice and drag it on top of the notebook that
you want to move it to.
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Synchronizing

You can synronize you notes with you ubuntu one account, this means that
you can access them across all of your ubuntu computer. You can also access
them from https://one.ubuntu.com/.

To synronize you notes cli the Edit, then cli Preferences, this will
open the “Tomboy Preferences” window. Cli the Synronization tab and
then in the Service drop down cli Tomboy Web.

Next cli theConnect to Server buon, this will open aweb page in Firefox
you will need to enter the e-mail address that you use for ubuntu one and your
password. en cli the Continue buon, then in the Computer Name text
field enter a name that reminds you of that computer and cli the Add is
Computer buon. Firefox will then display a page that says something similar
to “Tomboy Web Authorization Successful”

Now ba at the “Tomboy Preferences” window cli the Save buon. A
new window will pop up asking if you want to “synronize your notes now,”
cli the Yes buon and the “Synronizing Notes …” window will show, once
the synronization is complete cli the Close buon.

If you want to synronize the notes again cli Tools and cli Synronize
Notes. Your notes will start synronizing, when they are done cli the close

https://one.ubuntu.com/
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Using your devices

Ubuntu supports a wide range of hardware, and support for new hardware im-
proves with every release.

Hardware Identification

To identify your hardware you can install the following application, cliAppli-
cations scroll down to Ubuntu Soware Center, When the “Ubuntu Soware
Centre” window opens use the sear box in the top right and sear for the
following “sysinfo” Now cli More Info and then cli Install to install the
application.

Now to run the application go to Applications System Tools Sysinfo the
program should open up providing you with access to information about all
your hardware on your system.

Keyboard and mouse

e keyboard and mouse are essential input devices for a large number of com-
puter users today. Being a very common piece of kit for many computer users
has led to some variation in the mouses and keyboards on offer today. In this
section we will look at the different seings of your keyboard and mouse whi
will be of great use to international users.

Keyboard

e keyboard is likely to be one of the main ways that you interact with your
computer. Without a keyboard this manual couldn’t be wrien by the Ubuntu
Manual team! Unfortunately not all keyboards are uniform in design, they can
differ by country, by language or even by style. As an American if by mistake
you purase a keyboard from a UK retailer, then not only will you find that the

Displays

Hardware Drivers

A hardware driver is a small bit of code paaged in a file, whi tells your com-
puter how to utilize a piece of hardware. Every component in a computer re-
quires a hardware driver to function, whether it’s the printer, DVD player, hard
disk, or graphics card. Your graphics device is the component in your computer
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that powers your display. When you’re wating videos on YouTube or DVDs
or simply enjoying the smooth transition effects when you maximize/minimize
your windows, your graphics device is doing the hard work behind the scenes.

Majority of the Graphics Devices are manufactured by three well known
companies: Intel®, AMD/ATI®and NVIDIA®corp. You can find your device
manufacturer by referring to your computer manual or looking for the specifi-
cations of your particular model over the Internet. e Ubuntu Soware Center
houses a number of programs that allow detailed system information to be ob-
tained. SysInfo is one su program that you can use to find relevant informa-
tion about your System devices. Ubuntu comes with support for graphics de-
vices manufactured by above companies, and many others, out of the box. at
means that you don’t have to find and install any drivers by yourself, Ubuntu
takes care of it on its own.

In keeping with Ubuntu’s philosophy, the drivers that are used by default
for powering graphics devices are open source. is means that the drivers can
be modified by the Ubuntu developers and problems with them can be fixed.
However in some cases the proprietary driver (restricted driver) provided by
the company may provide beer performance or features that are not present
in the open source driver wrien by the developer community. In other cases,
your particular device may not be supported by the open source drivers yet. In
those scenarios, you may want to install the restricted driver provided by the
manufacturer.

For both philosophical and practical reasons, Ubuntu does not install re-
stricted drivers from the start but allows the user to make an informed oice.
Remember that restricted drivers, unlike the open source drivers for your de-
vice, are not maintained by Ubuntu. Problems caused by those drivers will be
resolved only when the manufacturer wishes to address them. To see if re-
stricted drivers are available for your system, cli System in the top panel, go
to Administration and find Hardware Drivers. If a driver is provided by the
company for your particular device, it will be listed there. You can simply cli
Activate and use the driver if you want. is process will require an active
Internet connection and will ask for your password.

e Ubuntu developers prefer open source drivers because they allow the
problem to be identified and fixed by anyone with knowledge in the community.
Ubuntu development is extremely fast and it is a good ance that your device
will be supported by open source drivers. You can use the Ubuntu Live CD to
e for your device compatibility before installing Ubuntu or go online in the
Ubuntu forums to ask about your particular device. Another useful resource
is the official online documentation (help.ubuntu.com), whi contains detailed
information about various graphics drivers and known quirks.
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Seing up your Screen Resolution

One of the most common display related tasks is seing up your screen reso-
lution. ink of Screen Resolution in terms of displayable information on the
your monitor/LCD; the higher the resolution, the beer the result. Your moni-
tor/LCD has a “native resolution,” whi is the highest resolution it designed to
work at. Ubuntu correctly identifies that screen resolution by itself and sets it
for you. However, due to a huge variety of devices out there, sometimes it can
make a mistake and set up an undesirable resolution.

To set up or just e your screen resolution, go to System. Cli Prefer-
ences and findDisplay. e Display application shows you your monitor name
and size, the screen resolution and refresh rate. Cliing on the displayed reso-
lution for e.g.  x  (:), would open a drop-down menu from where you
can select the resolution of your oice.

Connecting and using your printer

You can add, remove, and ange printer properties by cliing System then
cliingAdministration and then Printing. is shows the “Printing-localhost”
window.

When you use and add printer it will need to be plugged in with a usb lead
or connected to you network. It will also need to be swited on.

Adding a local printer

If you have a printer that is connected to your computer with a usb lead then
this is a local printer. You can add a printer by cliing Server, then cliing
New then Printer. e “New Printer” window will open.

In the le hand pain of the “New Printer” window any printers that you can
install will be listed. Select the printer that you would like to install and cli
the Forward

If your printer can automatically do double sided printing and it will proba-
bly have a duplexer. Please refer to the instructions that came with the printer
if you are unsure. If you do have a duplexer you will need to make sure the
Duplexer Installed option is eed and then cli the Forward buon.

You can now specify the printer name, description and location. Ea of
these should remind you of that particular printer so that you can oose the
right one to use when printing.

Adding a network printer

Seing default printer

Changing printer options
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Sound

USB drives

Burning CDs and DVDs

To create a CD or DVD cli the Applications then cli Sound and Video
and cli Brasero Disc Burner. is opens the “Brasero” window, this window
has a side bar that gives yo five options to oose from. Ea one of these is
explained.

Figure .: Brasero burns music, video, and
data DVDs and CDs.

Universal options

ese options apply for all projects except Disc copy and Burn Image
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Adding files to a project

To add files to the list cli the Green + buon, this opens the “Select Files”
window will open. en navigate you way to the file that you want to add and
cli it and then cli the Add buon. Repeat this process for ea file that you
want to add.

Saving a project

To save a project so that you can finish it later, cli Project then cli Save.
e “Save Current Project” window will show, oose where you would like to
save the project. en in the Name: text field name the project so that you will
remember it. en cli the Save buon.

Removing files

If you want to remove a file from the project, cli the file in the list and cli the
Red - buon. To remove all the files in the list cli the Broom shaped buon.

Burning the disc

Blanking a disk

If you are using a disk that has “RW” wrien on it and you have used it before
then you can blank it so that you can use it again. By doing this you will lose
all of the data currently on the disk. To blank a disc cli the Tools menu and
then cli Blank, the “Disc Blanking” window will show. In the Select a disc
drop down oose the disc that you would like to blank.

You can enable the Fast blank option if you would like to make it quier.
However this will not fully remove the files and if you have any sensitive data
on it would be best not to enable the Fast blank option.

Once the disc is blank the “e disc was successfully blanked” window is
shown cli the close buon to finish.

Audio project

If you record your own music then you may want to make it into an audio cd
so that your friends and family can listen. You can start an audio project by
cliing Project then cliing New Project and then New Audio Project.

So that ea file does not play straight aer ea other you can add a two
second pause aer a file. is can be done by cliing the file and then cliing
the || buon.

You can slice files into parts by cliing the Knife like buon, this opens a
“Split Tra” window. e Method drop down gives you four options ea one
of these lets you split the tra in a different way. Once you have split the tra
cli the OK.
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In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en cli the
Burn… buon.

Data project

If you want to make a ba up of your documents or photos it would be best
to make a data project. You can start a data project by cliing Project then
cliing New Project and then New Data Project

If you want to add a folder you can cli the Folder picture, then type the
name

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en cli the
Burn… buon.

Video project

If you want to make a dvd of your family videos it would be best to make a
video project. You can start a video project by cliing Project then cliing
New Project and then New Video Project

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en cli the
Burn… buon.

Disc copy

You may want to copy a disc so that you have another copy of

Burn image

Using a webcam

Scanning text and images

Most of the time, Ubuntu will simply detect your scanner and you just be able
to use it. To scan a document, you need to follow these steps:

. Place what you want to scan on the scanner.
. Go to Applications ‣Graphics ‣XSane Image Scanner.
. Alternately, pressing the scan buon on the scanner should also work.

Does my scanner work with Ubuntu?

ere are three ways to see if you scanner works in Ubuntu:

. Simply plug it in. If it is a newer USB scanner, it is likely that it will just
work.
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. Che https://wiki.ubuntu.com/HardwareSupportComponentsScannerswhi
is Ubuntu specific.

. SANE project listing of support scanners. e SANE (Scanner Access Now
Easy) project provides most of the baends to the scanning soware on
Ubuntu.

Ubuntu can’t find my scanner

ere are a few reason why Ubuntu may give you a “No devices avaliable mes-
sage”:

‣ Your scanner is not supported in Ubuntu. e most common type of scanner
not supported is old parallel port or Lexmark All-in-One printer/scanner/-
faxes.

‣ e driver for your scanner is not being autoloaded.
‣ You need to install the firmware file (probably a *.fw or *.usb) for your

particular scanner. You simply need to copy the file into /usr/share/sane/.
In my case I got the firmware file from the CD that came with the scanner (if
the file is not there, try installing the cd with WINE- don’t use the program
but sear for the needed file and copy it or do a qui internet sear) and
copied this file “ccd.fw” into /usr/share/sane/gtxx/

‣ You have a parallel port scanner and you are not a member of the scanner
group. e device /dev/parport (or whiever parallel port your scanner is
connected to) by default is only readable and writable by user lp and group
scanner. You can become member of group scanner via the User Privileges
tab of the Account Properties dialog in the User Seings (Users and Groups)
administration tool.

Other devices

Firewire

Bluetooth

https://wiki.ubuntu.com/HardwareSupportComponentsScanners




 Soware and Packaging

Soware management in Ubuntu

On occasion, you may find that you need some additional soware. You may
decide to get an alternative web browser, or a different email program. You may
need to do audio editing, or you may want to install some games.

Ubuntu is designed to make soware very easy to find and install. Ubuntu
keeps tra of tens of thousands of different soware, and helps you install the
ones you want and then keep them up to date.

Differences with other operating systems

In most other operating systems, installing soware requires you to purase it
in a store, or find and install soware from a site on the internet.

In Ubuntu, you can install soware in the same manner. However, you can
also install over , soware paages from the Ubuntu Soware Center.
e Soware Center is a central location for soware that the developers of
Ubuntu have tested and determined to work with Ubuntu.

While other operating systems do not differentiate the sources of soware,
Ubuntu has a concept of repositories. A repository is a catalog of soware that
is available to an operating system.

When you install Ubuntu, you will automatically have access to the official
Ubuntu repositories. You can oose to add additional repositories so that you
can access additional soware.

Soware in Ubuntu is delivered in paages. A paage is a collection of
code that runs the application. In Ubuntu, applications can share paages to
minimize hard drive usage and improve efficiency. ese shared paages are
called dependencies or libraries.

Using the Ubuntu Soware Center

e Ubuntu Soware Center is the most common way to install soware in
Ubuntu. e Soware Center can help you install most of the applications that
are available in the official repositories. Some soware, such as command line utili-

ties and some advanced servers, are not pos-
sible to install from the Soware Center. You
will need to use Synaptic PackageManager to
install these packages.

To start the Soware Center, open theApplicationsmenu andooseUbuntu
Soware Center. Ubuntu should then display the main window for the So-
ware Center.

e Soware Center window has two parts—a list of sections on the le,
and a set of icons on the right. Ea icon represents a department, whi is a
category of soware.
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Figure .: You can install and remove appli-
cations from your computer using the So-
ware Center.



software and packaging 

e sections on the le side of the window represent your current view of
the Soware Center’s catalog. Choose the “Get Free Soware” section from the
list to see soware in the catalog, or “Installed Soware” to see a list of soware
that is already installed on your computer.

Finding soware

If you are looking for some soware to install on your computer, you may know
the name of the soware (for example, “underbird” is a popular email appli-
cation), or you may just know the category of soware (for example, “audio
editor” describes a number of soware applications that can edit audio files).

To help you find soware, you can either browse the Soware Center cat-
alog by department, or use the built-in sear to look for soware by name or
keywords.

To browse browse the Soware Center’s catalog, oose the “Get Free So-
ware” section from the list on the le. e Soware Center should display a list
of departments su as “Office,” “Games,” or “Sound & Video”.

Installing soware

Installing applications is two mouse clis away. Once you find the soware
you are looking for,

. Cli on theá buon to the right of the selected application. Youwill be taken
to the application’s profile page. If you want to go ba, you can cli on the
buons on the top, they will look like this: Get Free Soware ‣ Selected
Category ‣ Selected application. Note: If your password does not work, you

are probably not permied to install soware
on the computer. If you have further prob-
lems, please go to Chapter : Troubleshoot-
ing.

. Cli the Install buon. You will be asked to input your password. is is
one of the in-built security features to prevent anyone else installing soware
that you might not want. If your authentication was granted, you will be
taken to the In Progress section while your application is installed.

. Wait until the application is finished installing. When operations—su as
application installations and removals—are currently running, you will see
an animated icon of rotating arrows to the le of In Progress section in the
sidebar. While waiting for the application to be downloaded and installed,
you can read details about the current operation, wat the progress bar fill
out, or cli the <sto-cancel> icon to cancel the operation. You can also
go ba to the main soware browsing window and queue other soware to
be installed.

Now you can run your application. Depending on what the program does, it
will appear on the Applications menu, System ‣Administration or System ‣
Preferences.

Removing soware

If you thought installing an application was simple, removing one is just as easy.
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To remove an application, follow these instructions:

. Find the application you want to remove (either by using the sear bar or by
filtering through categories).

. Go to its page by cliing on the á buon to its right, on the application list.
. Cli theUninstall buon. Youwill be asked to input your password. If your

authentication was granted, you will be taken to the In Progress section
while your application is installed. Your application will now be either in
process of removal or waiting in line for it, in the In Progress section.

e same as when you install a new application, when you remove one the
menus get updated too. is is one benefit of having an organized soware
management system.

Package managers

Paagemanagers—like the SowareCenter—are applications that interact with
the repositories. Paage managers will let you sear for, view information
about and install and remove applications and paages. Other additional ac-
tions or information you will be able to rea depend entirely on the paage
manager you are using.

e principal paage managers that Ubuntu provides are the Soware Cen-
ter and the Synaptic Paage Manager. To find out more about them, read
their respective sections in this apter.

Different ways to obtain soware

Even though Ubuntu provides the Soware Center and the official repositories
to help you install soware, there are other ways to get soware installed. To see more information about Security in

Ubuntu, visit Chapter : Security.

. Official repositories, the standardmethod of downloading soware. By get-
ting soware through the official repositories you ensure that your soware
is free of viruses or any other malware, that it is stable, and that it works
with Ubuntu.

. ird-party repositories that you can add to expand your soware sources.
ese repositories are not as reliable as the official ones: the repository main-
tainer can put whatever theywant into them. ere is no solid guarantee that
the soware inside them is secure, stable, or that it works with your system.
Read more instructions on this maer at Soware Sources.

. Installers / deb paages that you can download from soware websites,
CDs, USB drives, etc. is method is the most insecure of all. You should
only obtain soware this way when you trust the source. If you are new to
Ubuntu, then you are probably accustomed to obtain soware this way as
it’s similar to .exe files in Windows.
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Making more soware available
Note: You can open Soware Sources from
the Soware Center. Simply go to Edit ‣
Soware Sources.

e Soware Center will only list the applications available in the repositories
of your soware sources. To add more, or learn more about this, visit the Using
the Ubuntu Soware Center section.

Synaptic Package Manager

e Synaptic Paage Manager serves a similar purpose as the Ubuntu So-
ware Center, but gives your more control over dependencies and libraries. Note: If you are not very familiar with ad-

vanced computing in Ubuntu you may prob-
ably want to stick with the Soware Center.

e Synaptic Paage Manager is the most complete visual paage man-
ager available in Ubuntu. rough it, you will be able to access any paage in
your repositories; not just user applications.

e Synaptic PaageManagerwill come in handywhen you are looking to
perform actions other than just installing and removing paages. e Synaptic
Paage Manager lets you:

‣ Install any paage in your repositories. You can even select whi version
of a paage to install, but note that this option is not available for all the
paages.

‣ Reinstall in case the paage’s contents have been damaged, or you just want
to get the default version ba.

‣ Update every time a new version of the paage is released.
‣ Remove any paage you no longer need.
‣ Purgewhen you wish to remove completely a paage, including saved pref-

erences and stored configuration files.
‣ Fix broken paages.
‣ Che properties of any paage, su as version, contained files, paage

size, dependencies, and mu more.
‣ Read and save markings in your computer.

Usage

Using this paage manager is very simple once you understand the basics be-
hind it. Ideally, you will mark different actions to perform on different pa-
ages first, and then apply your anges. When you cli the Apply buon, the
Synaptic Paage Manager will do ea of your marked actions, one by one.
en you will be free to close the program, or wait until the process is complete
to make more anges.

To open the Synaptic Paage Manager go to System ‣Administration ‣
Synaptic Paage Manager.

Finding what you want

If you are having difficulties finding the paage you are looking for, you may
try the i sear box, the Sear buon (whi opens a sear dialog) or
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sort by the categories in the le side pane.
You can use the Reload buon when you have made anges to your so-

ware sources, su as adding or removing repositories, so that the paage man-
ager can notice the anges and act accordingly.

Applying Your Changes

Once you find the paage you are looking for, you can just open its right-cli
menu and there you will see listed all the actions you can perform on it. You
can alternatively access these options through the Paage menu.

When you are ready marking actions, cli the Apply buon and wait until
the anges are made. Aerwards, you can close the application or mark more
anges.

Soware Sources

e Soware Center—or the paage manager you are using—will list only ap-
plications that are available in the repositories of your soware sources. You can
add or remove repositories to your soware sources with the Soware Sources
application.

To start off, lets open the Soware Sources application in the System ‣
Administration ‣ Soware Sources.

Configuring the Ubuntu repositories

Ubuntu has four main repositories—whi classify as the official repositories
—whi contain different types of paages.

‣ Canonical-supported open source soware (main) - is repository con-
tains all the open source paages that Canonical helps maintain.

‣ Community-maintained open source soware (universe) - is reposi-
tory contains all the open source paages that the community helps write
and maintain.

‣ Proprietary drivers for devices (restricted) - is repository contains all
the drivers available to devices or hardware you may use with your com-
puter, whi are non-free.

‣ Soware restricted by copyright or legal issues (multiverse) -is reposi-
tory contains all other soware that, as the name suggests, might be illegal to
use in some countries or states, so it’s not enabled by default. However, you
can still use it if you enable this repository, under your own responsibility.

e Source code ebox should not be enabled unless you are used to
building applications from source. Building applications from source is an

advanced process that developers do to cre-
ate packages. The only time you would ever
need to build from source would be if you
were using a custom kernel or want the lat-
est version of an application that hasn’t been
packaged for Ubuntu yet. It’s considered an
advanced skill and therefore we don’t cover
building from source in this manual.
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Selecting the best soware server

Ubuntu grants permission to many servers all across the world to host exact
copies of the Ubuntu official repositories. Ubuntu does this so that wherever you
are you may have a server that is close to you to guarantee the best download
speed possible.

If your downloads are slow, you might be geing your soware from the
wrong server. ere are some aspects you should consider before selecting your
server:

‣ Connection speed. Depending on the physical distance between you and
your server, the connection speed may vary. Luily for you, Ubuntu had
thought about this long ago, and thus provides a tool to select the server to
whi your computer connects the best.

To select the fastest server available for you, cli the combobox of the
current server and select the Other menu option. Aer you are taken to the
server selection window, cli on the Select Best Server buon, to the upper
right. You will have to wait for your computer to connect to all the servers
and then select the server with whi it had the fastest connection.

‣ Location. You should oose the server closest to your location to provide
the best connection speed.

To select a server by country, cli on the drop-down menu of the cur-
rent server. A window with all the countries with Ubuntu servers and the
respective servers registered to them will appear.

‣ Security. is should not concern you at all, as Canonical ensures the third
party servers are trustworthy. However, if you still think you might be at
risk with just any server, you could select one of the Ubuntu secure servers,
su as the Main server or the http://ubuntu.securedservers.com server.

If you are not connected to the internet, you may insert your CD to your
computer and select the ebox in the Installable from the CD-ROM/DVD
box. Expect no more than the Cdrom with Ubuntu . ’Lucid Lynx’ inside
the box.

Configuring Updates

Because Ubuntu is a very customizable operating system, it lets you specify
whi kinds of updates you want to download. To customize your updates, go
to the Updates tab, in your Soware Sources window.

Ubuntu Updates

is is where you specify whi kinds of updates you will like to get installed
in your system.

‣ Important security updates - ese ensure that you get all the updates that
make Ubuntu su a secure operating system time and time again when they
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are released. As the title suggests, it is important that you enable these up-
dates.

‣ Recommended updates - ese updates are not mandatory or important,
but if you wish to keep your whole system up-to-date, you should consider
enabling them.

‣ Pre-released updates - ese updates are for those who just cannot wait
whenever new versions of applications are out. Note that these updates have
not being tested enough, so you may encounter problems with the updated
applications. However, if you did encounter a problem, you could easily
roll-ba to the previous version, using the Synaptic Paage Manager.

‣ Unsupported updates - ese are the updates that the Ubuntu staff has not
reviewed. Even though they are secure, as with the previous ones, you may
encounter problems when using them.

Automatic Updates

Here you can customize your systems behaviour towards updates. You can cus-
tomize whether ites for updates or not, if it should install important updates
right away (without asking for your permission), if it should only download
them, or if it should only notify you about them. You can also customize the
frequency with whi your system es for new updates.

Release Upgrade
Note: Every  months, Ubuntu releases a
new version of the operating system. These
are called normal releases. Every four nor-
mal releases—or  months—Ubuntu releases
a Long Term Support (LTS) release. Long
Term Support releases receive extra effort
from the developers so they are more stable,
and thus are used by companies that need
extra-reliable setups.

Here you can customize whi kind of system upgrades you will like to have
available.

‣ Never - Choose this if you don’t want to be notified about new Ubuntu
releases at all.

‣ Normal releases - Choose this if you always want to have the latest Ubuntu
release, no maer if it is Long Term Support or not. is option is recom-
mended for normal home users.

‣ Long Term Support releases only - Choose this option if you need a release
that will have—as the title suggests—support for a long time. If you own a
company and you have Ubuntu as the operating system for your employees,
you probably want to select this option.

Adding more soware repositories
Definition: A PPA is a Personal Package
Archive, or a third-party repository. The
PPAs are spaces where people host digital
projects, such as applications, documents,
and many more.

As you have probably read before in this apter, there is a way that you can get
soware, from a paagemanager, from third-party—or non-Ubuntu—repositories.
ese “third-party repositories” are called PPAs.

To add a PPA to your soware sources, go to the Other Soware tab in the
Soware Sources window.
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What you will need

. e PPA intelligent URL. To get it, go to the project owner’s launpad page,
whether it is a team or a single launpad user. When you are taken to the
page, look for a header labelled “Personal Paage Arives”; cli on the link
to the one that best mates the project you are trying to add a repository of.
en, you will be taken to a page titled “PPA for (…)”. Look for a link below,
in bold font, similar to this one: lp:paage. at’s your PPA intelligent
URL.

M I S S I N G S C R E E N S H O T

Screenshot of PPA page on Launchpad.

Figure .: Screenshot of PPA page on
Launchpad.

Note: The key file is the securitymethod used
by Ubuntu to ensure that you are the one who
is adding the PPA

. e key file. To get it, go to the same page where you got your PPA intelligent
URL. Now, instead of copying that URL, cli onTenical details about this
PPA link. en cli the link below the “Signing key” header. Aerwards,
make your last cli on the -digit code. Copy all the text in the page and
save it as a text file. at file is your key file.

Adding the PPA and authorizing the key

Aer you have the requirements, adding a PPA is a two step procedure:

. Add the PPA by cliing on the Add… buon, and copy the PPA intelligent
URL to the APT Line input box.

. Authorize the key by going to theAuthentication tab (in the Soware Sources
window) and cliing the Import Key File… buon. at will open up a
browser for you; find your key file and you are done.

Before closing Soware Sources, read the next section.
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Geing ready to use it

Because Ubuntu needs to keep tra of a long list—about , items long—
of applications, it just does not aempt to update it with every small ange
you make. You have to update it every time you ange a seing in Soware
Sources, su as adding a new repository/PPA.

Luily for you, upon closing Soware Sources you will be asked if you
want to reload the soware sources. To do so, cli the Reload buon. Aer
Soware Sources finishes reloading the database and closes itself, you will be
able to access your paage from any paage manager.
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Introduction to the terminal

roughout this manual, we have focused primarily on the graphical desktop
user interface. However in order to fully realise the power of Ubuntu, you may
want to learn how to use the terminal.

What is the terminal?

Most operating systems, including Ubuntu, have two types of user interfaces.
e first is a graphical user interface, also known as a GUI. is is the desktop,
windows, menus and toolbars that you cli to get things done. e second,
and mu older, type of interface is the command-line interface, also known as
a CLI.

e terminal is Ubuntu’s command-line interface. It is a method of con-
trolling some aspects of Ubuntu using only commands that you type on the
keyboard.

Why would I want to use the terminal?

For the average Ubuntu user, most day-to-day activities can be completed with-
out ever needing to open the terminal. However the terminal is a powerful and
invaluable tool that can be used to perform many useful tasks. For example:

‣ Troubleshooting any difficulties that may arise when using Ubuntu some-
times requires you to use the terminal.

‣ A command-line interface is sometimes a faster way to accomplish a task.
For example, it is oen easier to perform operations on many files at once
using the terminal.

‣ Learning the command-line interface is the first step towards more advanced
troubleshooting, system administration, and soware development skills. If
you are interested in becoming a developer or an advanced Ubuntu user,
knowledge of the command-line will be essential.

Opening the terminal
The terminal gives you access to what is
called a shell. When you type a com-
mand in the terminal the shell interprets this
command, resulting in the desired action.
There are different types of shells that accept
slightly different commands. The most popu-
lar is called “bash”, and is the default shell in
Ubuntu.

You can open the terminal by cliing Applications ‣Accessories ‣Terminal.

When the terminal window opens, it will be largely blank apart from some
text at the top le of the screen, followed by a blinking blo. is text is your
prompt—it displays your login name and your computer’s name, followed by
the current folder. e tilde ( ) means that the current folder is your home folder.



 the ubuntu manual

M I S S I N G S C R E E N S H O T

Screenshot of default terminal window

Figure .: Screenshot of default terminal
window

Finally, the blinking blo is the cursor—this marks where text will be entered
as you type.

To test things out, type pwd and press Enter. e terminal should display
“/home/your-username”. is text is called the “output”. You have just used
the “pwd” (print working folder) command, and the output that was displayed
shows the current folder.

All commands in the terminal follow the same approa. Type in the name of
a command, possibly followed by some parameters, and press Enter to perform
the specified action. Oen some output will be displayed that confirms the Parameters are extra segments of text, usually

added at the end of a command, that change
how the command itself is interpreted. These
usually take the form of -h or --help, for ex-
ample. In fact, --help can be added to most
commands to display a short description of
the command, as well as a list of any other
parameters that can be used with that com-
mand.

action was completed successfully, although this depends on the command. For
example, using the “cd” command toange your current folder (see below) will
ange the prompt, but will not display any output.

e rest of this apter covers some very common uses of the terminal,
however there are almost infinite possibilities available to you when using the
command-line interface in Ubuntu. roughout Part II of this manual we will
continue to refer to the command-line, particularly when discussing steps in-
volved in troubleshooting and the more advanced management of your com-
puter.

Geing started with the command-line

Navigating folders

e pwd command is short for print working directory. It can be used to display
the folder you are currently in. Note that the prompt (the text just before the
blinking cursor) also displays your current folder, so this command is not usually
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necessary. The terms directory and folder refer to the
same thing. They are used interchange-
ably throughout this manual as well as most
guides you may find online.$ pwd

/home/yourusername/

e cd command is short for ange directory. It allows you to ange from
one folder to another.

$ cd /directory/you/want/to/go/to/

Geing a list of files

e ls command is used to get a list of all the files and folders that exist inside
the current folder.

$ ls
folder1
folder2
file1.txt
file2.txt

Moving things around
Note that the terminal is case-sensitive. For
example, if you have a directory called
Folder, you must remember to include the
capital leer whenever referring to it in the
terminal, otherwise the command will not
work.

e mv command is used to move a file from one folder to another.

$ mv /move/this/file.txt /to/this/directory/

e cp command is used to copy a file from one folder into another.

$ cp /copy/this/file.txt /to/this/directory/

Creating directories

e mkdir command is short for make directory, and is used to create a new
directory in the current folder or another specified location. For example, this
command will make a folder called “newdirectory” inside the current folder:

$ mkdir newdirectory

is command will ignore your current folder, and instead make one called
“newdirectory” inside a hypothetical folder called /tmp/example/ :

$ mkdir /tmp/example/newdirectory

You could then ‘move into’ this new folder (i.e. make it your current working
directory), by using the cd command.

$ cd /tmp/example/newdirectory
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Deleting files and folders

e rm command is used to delete files. For example, to delete a file located in
your current folder:

$ rm deleteme.txt

To delete a file located in another folder (i.e. not inside your current working
directory), you would need to include the path to the file. In other words, you
are specifying the file’s location. For example:

$ rm /tmp/example/deleteme.txt

e rmdir command is similar to the rm command, except it is used to delete
folders. For example, this command would delete the folder called “newdirec-
tory” that we created earlier.

$ rmdir /tmp/example/newdirectory/

Introducing sudo

When Ubuntu is first installed two accounts are created; your primary user
account, and a ‘root’ account that operates behind the scenes. is root account
has the necessary privileges required for modifying system files and seings,
whereas your primary user account does not. Rather than logging out of your
primary user account and then logging ba in as root, the ‘sudo’ command can
be used to borrow root account privileges for performing administrative tasks
su as installing or removing soware, creating or removing new users, and
modifying system files.

For example, the following command would open Ubuntu’s default text ed-
itor gedit with root privileges. is then allows you to edit important system
files that would otherwise be protected. Your sudo password is the same pass-
word you use to login to your primary account, and is set up during the Ubuntu
install process. When using sudo in the terminal, you will be

prompted to enter your password. You will
not see any dots, stars or other characters ap-
pearing in the terminal as you type your pass-
word, however don’t be put off—this is an ex-
tra security feature to help protect you from
any prying eyes.

$ sudo gedit
[sudo] password for username:
Opening gedit...

e sudo command can give you virtually unlimited access to important system
files and seings. It is important you only use sudo if you understand what you
are doing. You can find out more about using sudo in Chapter : Security.
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Managing soware through the terminal

In Ubuntu there are a number of ways to manage your soware. GUI tools su
as the Ubuntu Soware Centre and Synaptic Paage Manager were discussed
in Chapter : Soware and Paaging, however many people prefer to use the
apt command (Advanced Paaging Tool) to manage their soware fromwithin
the terminal. Apt is extremely versatile and encompasses several tools, however
the most commonly used apt tool is the apt-get command.

Using apt-get

Apt-get is used for installing and removing paages from your system. It can
also be used to refresh the list of paages available in the repositories, as well
as download and install any new updates for your soware.

Updating and upgrading

e apt-get update command can be used to quily refresh the list of paages
that are available in the default Ubuntu repositories, as well as any additional
repositories added by the user (see Chapter : Soware and Paaging for more
information on repositories).

$ sudo apt-get update

You can then use apt-get upgrade to download and install any available up-
dates for your currently installed paages. It is best to run apt-get update prior
to running apt-get upgrade, as this will ensure you are geing the most recent
updates available for your soware.

$ sudo apt-get upgrade
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following packages will be upgraded:
tzdata
1 upgraded, 0 newly installed, 0 to remove and 0 not upgraded.
Need to get 683kB of archives.
After this operation, 24.6kB disk space will be freed.
Do you want to continue [Y/n]?

e terminal will give you a summary of what paages are to be upgraded,
the download size, and how mu extra disk space will be used (or freed), and
then ask you to confirm before continuing. Simply press ‘y’ then Enter, and the
upgrades will be downloaded and installed for you.
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Installing and removing

e following command would be used to install VLC media player using apt-
get : Notice the sudo command before the apt-get

command. In most cases it will be necessary
to use sudo when installing soware, as you
will be modifying protected parts of your sys-
tem. Many of the commands we will be using
from here on require root access, so expect to
see sudo appearing frequently.

$ sudo apt-get install vlc
[sudo] password for username:

To remove VLC, you would type:

$ sudo apt-get remove vlc

Cleaning up your system

Oen soware in Ubuntu depends on other paages being installed on your
system in order to run correctly. If you aempt to install a new paage and
these dependencies are not already installed, Ubuntu will automatically down-
load and install them for you at the same time (provided the correct paages
can be found in your repositories). When you remove a paage in Ubuntu
however, any dependencies that were installed alongside the original paage
are not also automatically removed. ese paages sit uselessly in your system
and can build up over time, taking up disk space. A simple way to clean up your
system is to use the apt-get autoremove command. is will select and remove
any paages that were automatically installed but no longer required.

$ sudo apt-get autoremove

Adding extra soware repositories

Sometimes you might want to install some soware that isnt in the official
repositories but may be available in a whats called a PPA, ppa’s or Personal
Paage Arives contain soware that you can install simply by adding that
ppa to your system, in versions of Ubuntu prior to Ubuntu . adding a ppa
to your system meant typing several really long commands in to a terminal,
however in Ubuntu . and later adding a ppa is as easy as typing one short
command into a terminal.

$ sudo add-apt-repository ppa:example/ppa

Now that you have installed a ppa you can just install soware from it the
usual way using the apt-get install command.

TODO: apt-get autoclean: removes all stored arives in cae for paages
that can no longer be downloaded (paages that are no longer in the repo or
that have a newer version in the repo).

apt-get clean: removes all stored arives in your cae.
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apt-cae: used for searing through the paages stored in the computer’s
repository cae.





 Security
is apter introduces how to keep your Ubuntu computer secure.

Why Ubuntu is safe

Ubuntu is secure by default due to a number of reasons:

‣ Ubuntu has a clear divide between normal users and administrative users
‣ Open source soware allows security flaws to be easily detected
‣ Security pates for open sources soware are oen released quily
‣ Many viruses target Windows based system and so do not affect Ubuntu

systems.

Security basics

is section describes basic security concepts and procedures.

Sudo

Ubuntu includes a special user, root, whi has full administration privileges.
Where as a normal user can only access their own files and can notmakeanges
to the system su as installing programs.

In Ubuntu the root account has been disabled to improve security and can
not be used directly. Instead the initial user account created during the install
process has permission to conduct administrative tasks by using the sudo com-
mand.

e sudo command allows a user to be given administration privilege for
a specific task. e following example runs the apt-get clean command as an
super-user:

$ sudo apt-get clean

sudo should only be used when needed. Operations that can be completed with-
out sudo should be executed as the normal user.

In addition to sudo the Ubuntu Desktop has a graphical version of sudo for
programs that require administration permissions. For example if a during a
system update the desktop is faded out and box asking for the user passwords
appears; this is to grant administration privileges permission to the user.

In Ubuntu, aer using sudo in a shell, there is a period of  minutes where
you will not have to reenter the sudo password again. Once this timelimit ex-
pires you wil be prompted to enter the sudo password again. It is possible to
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ange this timelimit to any time that you like. Seing the timeout to  will
mean that you will always be prompted for a password, it is also possible to
extend this grace period.

Users must be given permission to use the sudo command, this can be done
by adding users to the Admin group. See section Users and groups for details
of how to do this.

Only users that need administration access should be giving sudo permission.
Do not give administration privileges to all users tomake administration easier.

Basic security precautions

Separate user accounts

When Ubuntu is installed, it is set up for a single person to use. If more than one
person will use the computer, it is best for ea person to have their own indi-
vidual user account. is way ea user can have separate seings, documents,
and other files. If necessary, files can also be protected from being viewed or
modified by other users without administrative privileges. See Users and groups
for how to add additional users.

Passwords

Strong passwords are one of the simplest ways to increase the security of your
computer. Passwords should not use names, common words and phases.

By default the minimum length of a password in Ubuntu is  aracters.
is can be anged by executing the following command, where the number
following min and max are the minimum and maximum length of a password.

$ password required pam_unix.so nullok obscure min=6 max=8 md5

Regularly anging passwords also help to improve security. A users pass-
words can be set to expire aer a given time. e current seings for a user
password can be view by executing the following command.

$ sudo chage -l username

e following commands can be used to ange the expiry date of a pass-
word.

Set the expiry date of the current password to st April .

$ sudo chage -E 04/31/2010 username

Set the maximum number of days for a password to .

$ sudo chage -M 90 username
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Set today as the last day for the current password.

$ sudo chage -d username

e options of these commands above can be combined into a single com-
mand.

$ sudo chage -E 01/31/2008 -M 90 -d username

Locking the screen

When leaving your computer unaended lo the screen, this stops anyone us-
ing your computer and requires your password to unlo the screen. To lo
the screen:

‣ Cli the User Switer in the top right of the panel and then press Lo
Screen, or

‣ Press Control+Alt+L to lo the screen. is keyboard shortcut can beanged
in System ‣ Preferences ‣Keyboard Shortcuts.

System updates

Ubuntu provides soware and security updates; these updates should be applied
regularly. See Chapter ⁇: ⁇ for how to update your Ubuntu computer.

Trusting third party sources

Normally adding applications to your computer is done using the Soware Cen-
tre whi downloads soware from the Ubuntu repositories as described in
Chapter : Soware and Paaging. However sometimes it is necessary to added
soware from other sources. For example when an application is not available
in the Ubuntu repository or a newer version is needed to the one available.

Additional repositories are available from site su as nd Launpad PPAs
whi can be added as described in Chapter : Soware and Paaging. Some
applications can be downloaded as .deb paages from a the website of a project.
Alternately applications may be built from the source code for the application.

Using recognised sources su as a projects website, PPA or community
repositories su as s more secure than downloading applications from an arbi-
trary source.

Whenever using a third party source consider how trustworthy the source is
and be sure you know what it is you are installing.

Users and groups

Ubuntu, as with most PC Operating Systems, support multiple users accounts.
is allows ea user to have a separate user account. Ubuntu also has user

file:getdeb.net#getdeb.net.a
file:getdeb.net#getdeb.net.i
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groups, every user is a member of one or more groups. Every user also has a
group with the same name as the user, of whi the user is a member. Files and
folders can be set to be accessible by a user and a group. By default a users files
are only accessible by the user and system files are only accessible by the root
user.

M I S S I N G S C R E E N S H O T

Screenshoots of User and Groups window

Figure .: Screenshoots of User and Groups
window

Managing users

Management of users and groups can be done using the User and Group admin-
istration application, System ‣Administration ‣Users and Groups

Tomake adjustments to the user and group seing cli the keys icon next the
word “Cli to make anges.” is will produce a promote for your password
to grant sudo privileges while using the User and Groups application.

Adding a user Cli the Add User buon and complete the dialog whi ap-
pears. Privileges granted to the new user can be anged in the Privileges tab,
but in most cases the defaults privileges will be adequate. To create the user
cli the OK buon.

Modify a user Double cli on a user in the list of users or select a user and
cli the Properties buon. Change the details as required in the dialog that
appears. Cli OK to apply the anges.

Delete a user Select a user from the list and cli the Delete buon. is will
deactivate the users account, but not remove the home folder.
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Managing groups

Cli the Manage Groups buon to open the group management dialog.

Adding a group To add a group cli the Add buon. In the dialog window
that appears enter the group name and select the members of the group.

Modifying a group To alter the users in an existing group. Select a group and
cli the Properties buon. Select and de-select the users as required and cli
OK to apply the anges.

Deleting a group To delete a group select a group and cli delete.

Applying groups to files and folders

To ange the group of a file of folder open Nautilus and navigate to the file
or folder whi need the group to be anged. en either select the folder and
use the File ‣ Properties menu item or right cli on the file / folder and select
Properties. In the Properties dialog that appears Cli the the Permissions tab
and select the required group from the Groups dropdown box, and select close.

Using the command line

User and group management can also be aieved by using the command line.
It is recommended you use the graphical method above unless you have good
reason to use the command line. For more information see the Ubuntu Server
Guide hps://help.ubuntu.com/./ serverguide/C/user-management.html

Seing up a secure system

is section describes how to use additional security programs to increase the
security of your system.

Firewall

A firewall is used protect your computer against unauthorized access by people
on the Internet or your network. Firewalls blo connections to your computer
from unknown sources, whi helps to prevent security breaes.

Uncomplicated Firewall (UFW) is the standard firewall configuration pro-
gram in Ubuntu. It is a command line program, but there is a graphical interface
for it called Gufw. See Chapter : Soware and Paaging for how to install the
Gufw paage.

Once installed started Gfuw System ‣Administration ‣ Firewall configu-
ration. To enable the firewall cli the Enable e by default all incoming
connections are denied. is should be suitable for most users.

https://help.ubuntu.com/9.10/serverguide/C/user-management.html
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GUFW Window with Add service window

Figure .: GUFW Window with Add service
window

If you are running servers on your system you will need to open the ports
these services use. If you do not know what this means, then you are probably
not running any servers and you should not open any ports.

To open a port cli the Add buon. For most usages the the Preconfigued
tab can be used. Select allow from the first box and then select the program or
service required.

e simpletab can be used to allow access on a single port and theAdvanced
tab can be used to allow access on a range of ports.

Encryption

Ubuntu includes a number of tools to encrypt files and folders. Two common
methods will be covered here. For further information on using encryption with
single files and email see the UbuntuCommunityHelp hps://help.ubuntu.com/community.

Home folder

During the install process it is possible to ose to encrypted a user home folder,
see Chapter : Installation for how to do this.

Private folder

If you have not osen to encrypt a user home folder it is possible to encrypt a
single folder in a users home folder named Private. To do this:

. Install ecryptfs-utils.
. Run ecryptfs-setup-private to setup the private folder.

https://help.ubuntu.com/community
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. Enter your login password when prompted.
. Either oose a mount pass phrase or generate one.
. Record both pass phrases in a safe location. ese are required if you ever

have to recover your data manually.
. Logout and Log ba in to mount the encrypted folder.

Aer the Private folder has been setup any files or folders in Private folder
will be encrypted when wrien to the disk.

If you need to recover your encrypted filesmanually see hps://help.ubuntu.com/community/EncryptedPrivateDirectory.

https://help.ubuntu.com/community/EncryptedPrivateDirectory
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Resolving problems

Sometimes, things simply do not work as they are supposed to. From time
to time, we have all encountered problems seing up and using our Ubuntu
systems, but these glites are generally easily fixed. Below, we offer a trou-
bleshooting guide to help resolve basic problems that users may encounter while
using Ubuntu. If you exhaust the troubleshooting advice below, there are plenty
of other options for geing assistance and support. See Geing more help to
learn about community support.

Troubleshooting guide

e key to effective troubleshooting is to work slowly and methodically, doc-
umenting the anges that you make to your Ubuntu system. at way, you
will always be able to roll ba your work and also give fellow users informa-
tion about your previous aempts, in the unlikely event that you should need
to turn to the community for support.

I installed Windows and can no longer start Ubuntu

Sometimes, you may install Ubuntu and then decide to install Microso Win-
dows as a second operating system running side-by-side with Ubuntu. While
this is supported by Ubuntu, you may find that aer installing Windows you
may no longer be able to start Ubuntu.

When you first turn on your computer, Ubuntu or another operating system
must also be started by the bootloader. When you installed Ubuntu, you Definition: A bootloader is initial soware

that loads the operating system when you
turn on the computer.

installed an advanced bootloader called GRUB that allowed you to oose be-
tween the various operating systems on your computer, like Ubuntu, Windows
and others. However, when you installed Windows, you removed GRUB, tak-
ing away the option of whi operating system to start. You can easily restore
GRUB and your bootloader oice by using the CD you used to install Ubuntu.

Insert your Ubuntu CD into your computer and restart, making sure to have
your computer start the operating system that is on the CD itself (see Chapter :
Installation). Choose your language and select Try Ubuntu. Wait while the
soware loads, and then open a terminal. You will need to type some code
to restore your bootloader. On the Applications menu, cli Accessories, and
then cli the Terminal item. Enter the following:

$ fdisk -l
Disk /dev/hda: 120.0 GB, 120034123776 bytes
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255 heads, 63 sectors/track, 14593 cylinders
Units = cylinders of 16065 * 512 = 8225280 bytes
Device Boot Start End Blocks Id System
/dev/sda1 1 1224 64228+ 83 Linux
/dev/sda2 * 1225 2440 9767520 a5 Windows
/dev/sda3 2441 14593 97618972+ 5 Extended
/dev/sda4 14532 14593 498015 82 Linux swap
Partition table entries are not in disk order

is output means that your system (Linux) is installed on device /dev/sda,
but your computer is booting to /dev/sda (where Windows is located).

First, you need to create a place to manipulate your Ubuntu installation:

$ sudo mkdir /media/root

Now, you need to link your Ubuntu installation and this new folder:

$ sudo mount /dev/sda1 /media/root

If you’ve done this correctly, then you should see the following:

$ ls /media/root
bin dev home lib mnt root srv usr
boot etc initrd lib64 opt sbin sys var
cdrom initrd.img media proc selinux tmp vmlinuz

Now, you can reinstall GRUB:

$ sudo grub-install --root-directory=/media/root /dev/sda
Installation finished. No error reported.
This is the contents of the device map /boot/grub/device.map.
Check if this is correct or not. If any of the lines is incorrect,
fix it and re-run the script `grub-install'.
(hd0) /dev/sda

Now reboot your Ubuntu Live CD, removing the disk from the tray, and
enjoy your Ubuntu system once again!

My login screen no longer appears when I turn on my computer
or

The graphics on my screen appear corrupted

e simplest and easiest way to correct this issue is to order Ubuntu to reset the
graphics configuration. Press and hold Control, Alt and F. You should now
see a bla and white screen with a prompt for your username and password.
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Screenshot of a virtual terminal (i.e. ctrl-alt-F)

Figure .: Screenshot of a virtual terminal
(i.e. ctrl-alt-F)

Enter your username, press Enter, and then enter your password. Characters
will not appear on the screen as you enter your password. Do not worry—this
behavior is normal and was implemented for security purposes. en, enter the
following code and press enter:

$ sudo dpkg-reconfigure -phigh xserver-xorg

Enter your password at the prompt, as above. Allow Ubuntu to process the
command, then enter:

$ sudo reboot now

Ubuntu will reboot, and your login screen should be restored.

I forgot my password

If you forget your password in Ubuntu, you will need to reset it using the “Res-
cue mode”.

To start Rescue mode, shut down your computer and then power it up. As
the computer starts up, press Esc when you see the white-on-bla screen with
a countdown (the GRUB prompt). Select the Rescue mode option using the
arrow keys on your keyboard. Rescue mode should be the second item in the
list.

Wait while Ubuntu starts up. Youwill not see a normal login screen. Instead,
you will be presented with a terminal prompt along the lines of
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GRUB screen with Rescue Mode option highlighted

Figure .: GRUB screen with Rescue Mode
option highlighted

root@something#

To reset your password, enter:

$ passwd username

Replace ’username’ above with your username. Ubuntu will prompt you for a
new password. Enter your desired password, press enter and then enter your
password again, pressing enter aer you are done. Ubuntu asks for your pass-
word twice to make sure you did not make a mistake while typing. Once you
have restored your password, return to the normal system environment by en-
tering:

$ init 2

Login as usual and continue enjoying Ubuntu.

Some text looks incorrect or corrupted

If you are seeing some text that looks odd or fails to display entirely, the designer
probably intended it to be viewed using fonts that are not installed on your
computer. is can be fixed by installing the missing fonts, available in the
Universe repository. See Chapter : Soware and Paaging (Configuring the
Ubuntu Repositories) to enable this repository.

Open the Synaptic Paage Manager .by navigating to the System menu in

.

.
Determine if this is possible to
perform with the Soware Center
in Lucid .

the top-le corner of the screen and oosing Administration and then Synap-
tic Paage Manager. Enter your password when prompted. In the sear
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box in the top toolbar of the application, enter mscorefonts. Mark the paage
ttf-mscorefonts-installer for installation. Cli Apply in the top toolbar, then
wait while Ubuntu installs the fonts.

Refreshing the troublesome page or reopening the offending document should
fix the problem.

Where are my deleted files?

If you have deleted a file by accident, youmay be able to recover it fromUbuntu’s
“Trash” folder. is is a special folder where Ubuntu stores deleted files. To ac-
cess the “Trash” folder, select the Places menu, and oose Computer. Ubuntu
will open the “Computer - File Browser” window. Choose Trash from the list of
places in the le-hand sidebar of the window. To remove items from the trash,
simply drag them wherever you would like.

I can’t play certain audio or video files, or interact with someweb-
sites

Many of the formats used to deliver ri media content are proprietary, mean-
ing they are not free to use, modify and distribute with an open source operating
system like Ubuntu. erefore, the default Ubuntu installation does not include
the ability to use these formats. If you find yourself in need of a proprietary
format, you may install the files necessary for using this format with one com-
mand. Make sure you have your Universe and Restriced repositories enabled.
See Synaptic Paage Manager (Configuring the Ubuntu Repositories) to enable
this repository.

Open the Synaptic Paage Manager by navigating to the System menu in
the top-le corner of the screen and oosing Administration and then Synap-
tic Paage Manager. In the sear box in the top toolbar of the application,
enter ubuntu-restricted-extras. Mark the paage ubuntu-restricted-extras
for installation. Cli Apply in the top toolbar, then wait while Ubuntu installs
the appropriate soware.

Once this command has finished, your ri media content item should work
properly.

Everything on my monitor is too big or too small

How can I change my screen resolution?

e image on every monitor is made up of millions of lile colored dots called
pixels. Changing the number of pixels displayed is called anging the resolu-
tion. Increasing the resolution will make the displayed images sharper, but will
also tend to make them smaller. e opposite is true when screen resolution
is decreased. Most monitors have a “native resolution”, whi is a resolution
that most closely mates the number of actual pixels in the monitor. Your dis-
play will usually be sharpest when your operating system uses a resolution that
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mates your display’s native resolution.
e Ubuntu configuration utility Display allows users to ange the resolu-

tion. Open it by oosing System from the Main Menu, then oosing Prefer-
ences and then Display. e resolution can be anged using the drop down
list within the program. Piing options higher up on the list, those with larger
numbers, will increase the resolution.

M I S S I N G S C R E E N S H O T

gnome-display-properties screenshot with resolution dropdown open

Figure .: gnome-display-properties screen-
shot with resolution dropdown open

Test out various resolutions by cliing Apply at the boom of the window.
Typically the highest resolution will be the native resolution. Selecting a reso-
lution and cliing Apply will temporarily ange the screen resolution to the
selected value. A dialog box will also be displayed. It gives the option of revert-
ing to the previous resolution seing or keeping new resolution. e dialog box
will time out in  seconds, restoring the old resolution.

is feature was implemented to prevent the user from being loed out of
the computer by a poorly-rendering resolution. When you have finished seing
the screen resolution, cli Close.

Ubuntu is not working properly on my Apple MacBook or Mac-
Book Pro

Ubuntu installations on Apple hardware oen do not enable the use of all of the
built-in hardware, including the iSight camera and the wireless internet adapter.
e Ubuntu community offers documentation on fixing these and other prob-
lems. If you are having trouble installing or using Ubuntu on your Apple lap-
top, please follow the instructions at https://help.ubuntu.com/community/

https://help.ubuntu.com/community/MacBook
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gnome-display-properties screenshot of confirm or revert dialog

Figure .: gnome-display-properties screen-
shot of confirm or revert dialog

MacBook. You can select the appropriate guide aer identifying your laptop
model number. Instructions are included on the web page above.

Ubuntu is not working properly on my Asus EeePC

Ubuntu installations on EeePC hardware oen do not enable the use of all
of the built-in hardware, including the keyboard hotkeys and the wireless in-
ternet adapter. e Ubuntu community offers documentation on fixing these
and other problems. If you are having trouble installing or using Ubuntu on
your Asus EeePC, please follow the instructions at https://help.ubuntu.com/
community/EeePC. is documentation page also links to a specific installation
guide for EeePC hardware.

My hardware is not working

Ubuntu sometimes has problems running on certain computers, generally when
hardware manufacturers use non-standard or proprietary components. e
Ubuntu community offers documentation to help you troubleshoot whatever
issues arise, including problems with wireless cards, scanners, mice and print-
ers. e complete guide can be found on Ubuntu’s support wiki, accesible at
https://wiki.ubuntu.com/HardwareSupport. If you continue to need sup-
port, please see Geing more help for more troubleshooting options, including
human assistance.

System maintenance

https://help.ubuntu.com/community/MacBook
https://help.ubuntu.com/community/MacBook
https://help.ubuntu.com/community/MacBook
https://help.ubuntu.com/community/EeePC
https://help.ubuntu.com/community/EeePC
https://wiki.ubuntu.com/HardwareSupport
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Cleaning unused packages

Over time, Ubuntu’s soware paaging system can accumulate unused pa-
ages or temporary files. ese temporary files, also called caes, contain pa-
age files from all of the paages that you have ever installed. Eventually, this
cae can grow quite large.

To clear the cae, you can either use the clean, or the autoclean option for a
command-line program called apt-get. e clean command will remove every
single cae item, and the autoclean command only remove caed items that
can no longer be downloaded. Items that can no longer be downloaded are
generally useless. To run clean, open a terminal window and type:

$ sudo apt-get clean

Paages can also become unused over time. If a paage was installed to
satisfy a dependency of a program, and then that program was removed, you
no longer need the paage. is means that it is useless and you can remove it
with the autoremove option.

Go to a terminal and type:

$ sudo apt-get autoremove

to remove the useless paages.

Clearing the package cache

To clear out the cae one can run the command: .
.

.
is is covered twice above al-
ready

.

$ sudo apt-get clean

iswill remove everything except the lofiles from the following locations:
/var/cae/apt/arives/ and /var/cae/apt/arives/partial/ . .

..
Must we mention these los here? .

Purge an Application

To totally remove an application and its configuration files (as well as delet-
ing the application paage install files, the cae) one can use the following
command, replacing paagename with the paage to be purged:

$ sudo apt-get purge packagename

is purge command is useful to use if an application is giving you trouble,
and you would like to reinstall it from scrat.
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Performing a file system check

Geing more help

is guide does not cover every possible workflow, task or issue in Ubuntu.
If you require assistance beyond the information in the manual, you can find
a variety of support opportunties online. You can access extensive and free
documentation, buy professional support services, query the community for
free support or explore tenical solutions. More information is available here:
http://www.ubuntu.com/support

http://www.ubuntu.com/support




 Learningmore aboutUbuntu

What else can I do with Ubuntu?

By now, you should be able to use your Ubuntu desktop to do all your normal
day to day activities—like browsing the web and editing documents. But you
may be interested in learning about other versions of Ubuntu you can integrate
into your digital lifestyle. In this apter, we’ll provide you with more detail
about versions of Ubuntu that are specialized for certain tasks. To do this, we’ll
first discuss the tenologies that make Ubuntu a powerful piece of soware.

Open source soware

Ubuntu is open source soware. Simply put, open source soware is soware
whose source code isn’t owned exclusively by any one person, group or organi-
zation, but is rather made freely available. is makes Ubuntu different from Definition: The source code of a program

is the files that have been wrien to make the
program.

proprietary soware, whi requires users to purase licenses before they are
able to use the soware on their computers. Microso Windows and Adobe Definition: Proprietary soware is so-

ware that cannot be copied, modified, or dis-
tributed freely.

Photoshop are examples of propritary soware.
Computer users can share and distribute open source sowarewithout fear of

breaking intellectual property laws. ey can also modify open source soware
to suit their individual needs, improve it, or translate it into other languages—as
long as they release their anges to others who might wish to do the same. Be-
cause open source soware is developed by large communities of programmers
distributed throughout the globe, it benefits from rapid development cycles and
speedy security releases (in the event that someone discovers bugs in the so-
ware). In other words, open source soware is updated, enhanced, and made
more secure every day as programmers all over the world continue to improve
it.

Aside from these tenical advantages, open source soware also has eco-
nomic benefits. Most open source programs cost nothing to obtain or run. Users
needn’t purases a license to run Ubuntu, for example.

To learn more about open source soware, see the Open Source Initiative’s
open source definition, available at http://www.opensource.org/docs/definition.
php

Distribution families

Ubuntu is one of several popular operating systems based on GNU/Linux (an
open source operating system). While other versions of GNU/Linux, or “dis-
tributions,” may look different from Ubuntu at first glance, they share similar
aracteristics because of their common roots. Distribution: A distribution, or “distro”, is

a operating system made from open source
programs, bundled together to make them
easier to install and use.

http://www.opensource.org/docs/definition.php
http://www.opensource.org/docs/definition.php
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GNU/Linux distributions can be divided into two broad families: the Debian
family and the Red Hat family. Ea family is named for a distribution on
whi subsequnt distributions are based. For example, “Debian” refers to both
the name of a distribution as well as the family of distributions derived from
Debian. Ubuntu is part of the Debian family of distributions, as are Linux Mint,
Xandros and Crunbang Linux. Distributions in the Red Hat family include
Fedora, OpenSUSE, and Mandriva.

e most significant difference between Debian-based and Red Hat-based
distros is the system ea uses for installing and updating soware. ese sys-
tems are called “paage management systems.” Debian soware paages Definition: Package management sys-

tems are the means by which users can in-
stall, remove, and organize soware installed
on computers with open source operating
systems like Ubuntu.

are .deb files, while Red Hat soware paages are .rpms files.
You will also find distributions that have been specialized for certain tasks.

Next, we’ll describe these versions of Ubuntu and explain the uses for whi
ea has been developed.

Choosing amongst Ubuntu and its derivatives

Just as Ubuntu is based on Debian, several distributions are subsequently based
on Ubuntu. Some of these aremade for general use, and ea differs with respect
to the soware included as part of the distribution. Others are designed for
specialized uses.

Four derivative distributions are officially recognized and supported by both
Canonical and the Ubuntu community. ese are:

‣ Ubuntu Netbook Remix, whi is optimized for netbook computers.
‣ Kubuntu, whi uses theKDE graphical environment instead of the GNOME

environment found in Ubuntu.
‣ Edubuntu, whi is designed for use in sools.
‣ Ubuntu Server Edition, whi is designed for use on servers, and typically

is not used as a desktop operating system (because users must interact with
it via the command line).

ree other officially recognized derivatives of Ubuntu are available. ese
include:

‣ Xubuntu, whiuses theXFCE graphical environment instead of theGNOME
environment used by Ubuntu.

‣ Ubuntu Studio, whi is designed for creating and editing multimedia.
‣ Mythbuntu, whi is designed for creating a home theater PC with MythTV

(an open source digital video recorder)

For more information about these derivative distributions, see http://www.
ubuntu.com/products/whatisubuntu/derivatives.

http://www.ubuntu.com/products/whatisubuntu/derivatives
http://www.ubuntu.com/products/whatisubuntu/derivatives
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Using Ubuntu Netbook Remix

Ubuntu Netbook Remix is a version of Ubuntu designed specifically for net-
book computers. It is optimized to run on Intel Atom processors—the most
common processor found in netbooks from manufacturers like ASUS, Acer, HP,
and Dell. Ubuntu Netbook Remix sports an interface tailored to fit netbooks’
smaller screens, and features a collection of soware applications particularly
useful to on-the-go users.

Because many netbooks do not contain cd-rom drives, Ubuntu Netbook
Remix allows users to install it on their computers using USB flash drives. To
learn more about using a flash drive to install Ubuntu Netbook Remix on a net-
book computer, visit https://help.ubuntu.com/community/Installation/FromImgFiles.

Using Ubuntu Server Edition

You can carry out nearly all your day-to-daywork on a standard desktopUbuntu
distribution. However, some tasks oen require more specialized distributions.
Su tasks include running a website or an email system. In these cases, you
maywish to use a specialized server distribution in conjuntionwith server hard-
ware. Computers performing these tasks run perpetually and consume quite a
lot of power. It is possible to run a server distribution on a desktop computer,
but we recommend doing this only for testing purposes.

is manual does not cover the process of running a secure webserver or
performing other taskswith Ubuntu Server Edition. Formore information about
this edition, see the guide at http://doc.ubuntu.com/ubuntu/serverguide/
C/.

Using Ubuntu Studio

is derivative of Ubuntu is designed specifically for people who use computers
to create and edit multimedia projects. For instance, it features applications
to help users manipulate images, create musical compositions, and edit video.
While users can install these applications on computers running the desktop
version of Ubuntu, Ubuntu Studio collects makes them all avaialble immediately
upon installation.

If you would like to learn more about this derivative of Ubuntu (or obtain a
copy for yourself), visit http://ubuntustudio.org/home.

Using Mythbuntu

Mythbuntu allows users to turn their computers into entertainment systems. It
helps users organize and view various types of multimedia content—likemovies,
television shows, or video podcasts. Users with TV tuners in their computers
can also use Mythbuntu to record live video.

To learn more about Mythbuntu, visit http://www.mythbuntu.org/.

https://help.ubuntu.com/community/Installation/FromImgFiles
http://doc.ubuntu.com/ubuntu/serverguide/C/
http://doc.ubuntu.com/ubuntu/serverguide/C/
http://ubuntustudio.org/home
http://www.mythbuntu.org/
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 bit or  bit?

As mentioned earlier in this manual, Ubuntu and its derivatives are available
in two flavors: -bit and -bit. is difference refers to the way computers
process information. Computers capable of running -bit soware process in-
formation using more memory than computers running -bit soware. ese
computers can gain performance enhancements by running -bit soware.

Why oose one over another? Pay aention to the flavor you select in the
following cases:

‣ If your computer is fairly old (made before ), then you may want to
install the -bit flavor of Ubuntu. is is also the case for most netbooks.

‣ If your computer has more than GB of memory (ram), then you may want
the -bit flavor. Without it, you will not be able to use all of the memory.

In general, we recommend that you install the -bit flavor of Ubuntu.

Learning even more

is manual is not intended as an introduction to everything you might wish to
do with your Ubuntu computer. For more information reagarding specialized
tasks, please see the official Ubuntu documentation available either through the
blue help and support icon, or at http://help.ubuntu.com.

http://help.ubuntu.com


A License
THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF
THISCREATIVECOMMONSPUBLIC LICENSE (“CCPL”OR “LICENSE”). THE
WORK IS PROTECTEDBYCOPYRIGHTAND/OROTHERAPPLICABLE LAW.
ANY USE OF THEWORKOTHER THANAS AUTHORIZED UNDER THIS LI-
CENSE OR COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU
ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE.
TO THE EXTENT THIS LICENSE MAY BE CONSIDERED TO BE A CON-
TRACT, THE LICENSOR GRANTS YOU THE RIGHTS CONTAINED HERE IN
CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND CONDI-
TIONS.

. Definitions

(a) “Adaptation” means a work based upon the Work, or upon the Work
and other pre-existing works, su as a translation, adaptation, deriva-
tive work, arrangement of music or other alterations of a literary or artis-
tic work, or phonogram or performance and includes cinematographic
adaptations or any other form in whi the Work may be recast, trans-
formed, or adapted including in any form recognizably derived from the
original, except that a work that constitutes a Collection will not be con-
sidered an Adaptation for the purpose of this License. For the avoidance
of doubt, where the Work is a musical work, performance or phonogram,
the synronization of the Work in timed-relation with a moving image
(“syning”) will be considered an Adaptation for the purpose of this Li-
cense.

(b) “Collection” means a collection of literary or artistic works, su as en-
cyclopedias and anthologies, or performances, phonograms or broadcasts,
or other works or subject maer other than works listed in Section (f) be-
low, whi, by reason of the selection and arrangement of their contents,
constitute intellectual creations, in whi the Work is included in its en-
tirety in unmodified form along with one or more other contributions,
ea constituting separate and independent works in themselves, whi
together are assembled into a collective whole. A work that constitutes
a Collection will not be considered an Adaptation (as defined below) for
the purposes of this License.

(c) “Creative Commons Compatible License” means a license that is listed at
http://creativecommons.org/compatiblelicenses that has been ap-
proved by Creative Commons as being essentially equivalent to this Li-
cense, including, at a minimum, because that license: (i) contains terms

http://creativecommons.org/compatiblelicenses
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that have the same purpose, meaning and effect as the License Elements
of this License; and, (ii) explicitly permits the relicensing of adaptations
of works made available under that license under this License or a Cre-
ative Commons jurisdiction license with the same License Elements as
this License.

(d) “Distribute” means to make available to the public the original and copies
of the Work or Adaptation, as appropriate, through sale or other transfer
of ownership.

(e) “License Elements” means the following high-level license aributes as
selected by Licensor and indicated in the title of this License: Aribution,
ShareAlike.

(f) “Licensor”means the individual, individuals, entity or entities that offer(s)
the Work under the terms of this License.

(g) “Original Author” means, in the case of a literary or artistic work, the
individual, individuals, entity or entities who created the Work or if no
individual or entity can be identified, the publisher; and in addition (i)
in the case of a performance the actors, singers, musicians, dancers, and
other persons who act, sing, deliver, declaim, play in, interpret or other-
wise perform literary or artistic works or expressions of folklore; (ii) in the
case of a phonogram the producer being the person or legal entity who
first fixes the sounds of a performance or other sounds; and, (iii) in the
case of broadcasts, the organization that transmits the broadcast.

(h) “Work” means the literary and/or artistic work offered under the terms
of this License including without limitation any production in the liter-
ary, scientific and artistic domain, whatever may be the mode or form of
its expression including digital form, su as a book, pamphlet and other
writing; a lecture, address, sermon or other work of the same nature; a
dramatic or dramatico-musical work; a oreographic work or entertain-
ment in dumb show; a musical composition with or without words; a cin-
ematographic work to whi are assimilated works expressed by a process
analogous to cinematography; a work of drawing, painting, aritecture,
sculpture, engraving or lithography; a photographic work to whi are as-
similated works expressed by a process analogous to photography; a work
of applied art; an illustration, map, plan, sket or three-dimensional work
relative to geography, topography, aritecture or science; a performance;
a broadcast; a phonogram; a compilation of data to the extent it is pro-
tected as a copyrightable work; or a work performed by a variety or circus
performer to the extent it is not otherwise considered a literary or artistic
work.

(i) “You” means an individual or entity exercising rights under this License
who has not previously violated the terms of this License with respect to
the Work, or who has received express permission from the Licensor to
exercise rights under this License despite a previous violation.

(j) “Publicly Perform”means to perform public recitations of theWork and to



license 

communicate to the public those public recitations, by any means or pro-
cess, including by wire or wireless means or public digital performances;
to make available to the public Works in su a way that members of
the public may access these Works from a place and at a place individu-
ally osen by them; to perform the Work to the public by any means or
process and the communication to the public of the performances of the
Work, including by public digital performance; to broadcast and rebroad-
cast the Work by any means including signs, sounds or images.

(k) “Reproduce” means to make copies of the Work by any means including
without limitation by sound or visual recordings and the right of fixation
and reproducing fixations of the Work, including storage of a protected
performance or phonogram in digital form or other electronic medium.

. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or
restrict any uses free from copyright or rights arising from limitations or
exceptions that are provided for in connection with the copyright protection
under copyright law or other applicable laws.

. License Grant. Subject to the terms and conditions of this License, Licensor
hereby grants You a worldwide, royalty-free, non-exclusive, perpetual (for
the duration of the applicable copyright) license to exercise the rights in the
Work as stated below:

(a) to Reproduce the Work, to incorporate the Work into one or more Collec-
tions, and to Reproduce the Work as incorporated in the Collections;

(b) to create and Reproduce Adaptations provided that any su Adaptation,
including any translation in anymedium, takes reasonable steps to clearly
label, demarcate or otherwise identify thatanges weremade to the orig-
inal Work. For example, a translation could be marked “e original work
was translated from English to Spanish,” or a modification could indicate
“e original work has been modified.”;

(c) to Distribute and Publicly Perform the Work including as incorporated in
Collections; and,

(d) to Distribute and Publicly Perform Adaptations.
(e) For the avoidance of doubt:

i. Non-waivable Compulsory License Semes. In those jurisdictions in
whi the right to collect royalties through any statutory or compul-
sory licensing seme cannot be waived, the Licensor reserves the ex-
clusive right to collect su royalties for any exercise by You of the
rights granted under this License;

ii. Waivable Compulsory License Semes. In those jurisdictions inwhi
the right to collect royalties through any statutory or compulsory li-
censing seme can be waived, the Licensor waives the exclusive right
to collect su royalties for any exercise by You of the rights granted
under this License; and,

iii. Voluntary License Semes. e Licensor waives the right to collect
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royalties, whether individually or, in the event that the Licensor is
a member of a collecting society that administers voluntary licens-
ing semes, via that society, from any exercise by You of the rights
granted under this License.

e above rights may be exercised in all media and formats whether now
known or hereaer devised. e above rights include the right to make
su modifications as are tenically necessary to exercise the rights in
other media and formats. Subject to Section (f), all rights not expressly
granted by Licensor are hereby reserved.

. Restrictions. e license granted in Section  above is expressly made subject
to and limited by the following restrictions:

(a) You may Distribute or Publicly Perform the Work only under the terms of
this License. You must include a copy of, or the Uniform Resource Iden-
tifier (URI) for, this License with every copy of the Work You Distribute
or Publicly Perform. You may not offer or impose any terms on the Work
that restrict the terms of this License or the ability of the recipient of the
Work to exercise the rights granted to that recipient under the terms of
the License. You may not sublicense the Work. You must keep intact
all notices that refer to this License and to the disclaimer of warranties
with every copy of the Work You Distribute or Publicly Perform. When
You Distribute or Publicly Perform the Work, You may not impose any
effective tenological measures on the Work that restrict the ability of a
recipient of theWork from You to exercise the rights granted to that recip-
ient under the terms of the License. is Section (a) applies to the Work
as incorporated in a Collection, but this does not require the Collection
apart from the Work itself to be made subject to the terms of this License.
If You create a Collection, upon notice from any Licensor You must, to
the extent practicable, remove from the Collection any credit as required
by Section (c), as requested. If You create an Adaptation, upon notice
from any Licensor You must, to the extent practicable, remove from the
Adaptation any credit as required by Section (c), as requested.

(b) You may Distribute or Publicly Perform an Adaptation only under the
terms of: (i) this License; (ii) a later version of this License with the same
License Elements as this License; (iii) a Creative Commons jurisdiction
license (either this or a later license version) that contains the same Li-
cense Elements as this License (e.g., Aribution-ShareAlike . US)); (iv)
a Creative Commons Compatible License. If you license the Adaptation
under one of the licenses mentioned in (iv), you must comply with the
terms of that license. If you license the Adaptation under the terms of
any of the licenses mentioned in (i), (ii) or (iii) (the “Applicable License”),
you must comply with the terms of the Applicable License generally and
the following provisions: (I) You must include a copy of, or the URI for,
the Applicable License with every copy of eaAdaptation You Distribute
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or Publicly Perform; (II) You may not offer or impose any terms on the
Adaptation that restrict the terms of the Applicable License or the ability
of the recipient of the Adaptation to exercise the rights granted to that
recipient under the terms of the Applicable License; (III) You must keep
intact all notices that refer to the Applicable License and to the disclaimer
of warranties with every copy of the Work as included in the Adaptation
You Distribute or Publicly Perform; (IV) when You Distribute or Publicly
Perform the Adaptation, You may not impose any effective tenologi-
cal measures on the Adaptation that restrict the ability of a recipient of
the Adaptation from You to exercise the rights granted to that recipient
under the terms of the Applicable License. is Section (b) applies to
the Adaptation as incorporated in a Collection, but this does not require
the Collection apart from the Adaptation itself to be made subject to the
terms of the Applicable License.

(c) If You Distribute, or Publicly Perform the Work or any Adaptations or
Collections, You must, unless a request has been made pursuant to Sec-
tion (a), keep intact all copyright notices for the Work and provide, rea-
sonable to the medium or means You are utilizing: (i) the name of the
Original Author (or pseudonym, if applicable) if supplied, and/or if the
Original Author and/or Licensor designate another party or parties (e.g.,
a sponsor institute, publishing entity, journal) for aribution (“Aribu-
tion Parties”) in Licensor’s copyright notice, terms of service or by other
reasonable means, the name of su party or parties; (ii) the title of the
Work if supplied; (iii) to the extent reasonably practicable, the URI, if
any, that Licensor specifies to be associated with the Work, unless su
URI does not refer to the copyright notice or licensing information for the
Work; and (iv) , consistent with Ssection (b), in the case of an Adaptation,
a credit identifying the use of the Work in the Adaptation (e.g., “Fren
translation of theWork by Original Author,” or “Screenplay based on orig-
inal Work by Original Author”). e credit required by this Section (c)
may be implemented in any reasonable manner; provided, however, that
in the case of a Adaptation or Collection, at a minimum su credit will
appear, if a credit for all contributing authors of the Adaptation or Col-
lection appears, then as part of these credits and in a manner at least as
prominent as the credits for the other contributing authors. For the avoid-
ance of doubt, You may only use the credit required by this Section for
the purpose of aribution in the manner set out above and, by exercis-
ing Your rights under this License, You may not implicitly or explicitly
assert or imply any connection with, sponsorship or endorsement by the
Original Author, Licensor and/or Aribution Parties, as appropriate, of
You or Your use of the Work, without the separate, express prior wrien
permission of the Original Author, Licensor and/or Aribution Parties.

(d) Except as otherwise agreed in writing by the Licensor or as may be other-
wise permied by applicable law, if You Reproduce, Distribute or Publicly
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Perform the Work either by itself or as part of any Adaptations or Col-
lections, You must not distort, mutilate, modify or take other derogatory
action in relation to the Work whi would be prejudicial to the Original
Author’s honor or reputation. Licensor agrees that in those jurisdictions
(e.g. Japan), in whi any exercise of the right granted in Section (b) of
this License (the right to make Adaptations) would be deemed to be a dis-
tortion, mutilation, modification or other derogatory action prejudicial
to the Original Author’s honor and reputation, the Licensor will waive
or not assert, as appropriate, this Section, to the fullest extent permied
by the applicable national law, to enable You to reasonably exercise Your
right under Section (b) of this License (right to make Adaptations) but
not otherwise.

. Representations, Warranties and Disclaimer
UNLESSOTHERWISEMUTUALLYAGREEDTOBYTHEPARTIES INWRIT-
ING, LICENSOR OFFERS THEWORKAS-IS ANDMAKES NO REPRESEN-
TATIONS OR WARRANTIES OF ANY KIND CONCERNING THE WORK,
EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, INCLUDING, WITH-
OUT LIMITATION, WARRANTIES OF TITLE, MERCHANTIBILITY, FIT-
NESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, OR THE
ABSENCEOF LATENTOROTHERDEFECTS, ACCURACY, ORTHE PRES-
ENCE OF ABSENCE OF ERRORS, WHETHER OR NOT DISCOVERABLE.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO YOU.

. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLI-
CABLE LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON
ANY LEGAL THEORY FOR ANY SPECIAL, INCIDENTAL, CONSEQUEN-
TIAL, PUNITIVE OR EXEMPLARY DAMAGES ARISING OUT OF THIS
LICENSE OR THE USE OF THE WORK, EVEN IF LICENSOR HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

. Termination

(a) is License and the rights granted hereunder will terminate automati-
cally upon any brea by You of the terms of this License. Individuals
or entities who have received Adaptations or Collections from You under
this License, however, will not have their licenses terminated provided
su individuals or entities remain in full compliance with those licenses.
Sections , , , , , and  will survive any termination of this License.

(b) Subject to the above terms and conditions, the license granted here is per-
petual (for the duration of the applicable copyright in theWork). Notwith-
standing the above, Licensor reserves the right to release the Work under
different license terms or to stop distributing the Work at any time; pro-
vided, however that any su election will not serve to withdraw this
License (or any other license that has been, or is required to be, granted
under the terms of this License), and this License will continue in full
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force and effect unless terminated as stated above.

. Miscellaneous

(a) Ea time You Distribute or Publicly Perform the Work or a Collection,
the Licensor offers to the recipient a license to theWork on the same terms
and conditions as the license granted to You under this License.

(b) Ea time You Distribute or Publicly Perform an Adaptation, Licensor
offers to the recipient a license to the original Work on the same terms
and conditions as the license granted to You under this License.

(c) If any provision of this License is invalid or unenforceable under applica-
ble law, it shall not affect the validity or enforceability of the remainder
of the terms of this License, and without further action by the parties to
this agreement, su provision shall be reformed to the minimum extent
necessary to make su provision valid and enforceable.

(d) No term or provision of this License shall be deemedwaived and no brea
consented to unless su waiver or consent shall be in writing and signed
by the party to be arged with su waiver or consent.

(e) is License constitutes the entire agreement between the parties with re-
spect to theWork licensed here. ere are no understandings, agreements
or representations with respect to the Work not specified here. Licensor
shall not be bound by any additional provisions that may appear in any
communication from You. is License may not be modified without the
mutual wrien agreement of the Licensor and You.

(f) e rights granted under, and the subject maer referenced, in this Li-
cense were draed utilizing the terminology of the Berne Convention for
the Protection of Literary and Artistic Works (as amended on Septem-
ber , ), the Rome Convention of , the WIPO Copyright Treaty
of , the WIPO Performances and Phonograms Treaty of  and the
Universal Copyright Convention (as revised on July , ). ese rights
and subject maer take effect in the relevant jurisdiction in whi the
License terms are sought to be enforced according to the corresponding
provisions of the implementation of those treaty provisions in the appli-
cable national law. If the standard suite of rights granted under applicable
copyright law includes additional rights not granted under this License,
su additional rights are deemed to be included in the License; this Li-
cense is not intended to restrict the license of any rights under applicable
law.

Creative Commons Notice

Creative Commons is not a party to this License, and makes no warranty what-
soever in connectionwith theWork. Creative Commonswill not be liable to You
or any party on any legal theory for any damages whatsoever, including with-
out limitation any general, special, incidental or consequential damages arising
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in connection to this license. Notwithstanding the foregoing two () sentences,
if Creative Commons has expressly identified itself as the Licensor hereunder,
it shall have all rights and obligations of Licensor.

Except for the limited purpose of indicating to the public that the Work is
licensed under the CCPL, Creative Commons does not authorize the use by
either party of the trademark “Creative Commons” or any related trademark
or logo of Creative Commons without the prior wrien consent of Creative
Commons. Any permied use will be in compliance with Creative Commons’
then-current trademark usage guidelines, as may be published on its website or
otherwise made available upon request from time to time. For the avoidance of
doubt, this trademark restriction does not form part of the License.

Creative Commons may be contacted at http://creativecommons.org/.

http://creativecommons.org/


Glossary
applet An applet is a small program that runs in a panel that provides a useful

function su as starting a program, viewing the time, or accessing the main
menu.. , 

Canonical Canonical, the financial baer of Ubuntu, provides support for the
core Ubuntu system. It has over  paid staff members worldwide who en-
sure that the foundation of the operating system is stable, as well as e-
ing all the work submied by volunteer contributors. To learn more about
Canonical, go to http://www.canonical.com.. 

panel A panel is a bar that sits on the edge of your screen. It contains applets
whi provide useful functions su as running programs, viewing the time,
or accessing the main menu.. , 

http://www.canonical.com
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